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Evyapiories

Evyopiotd mapa modd tov Avipéa kot tov Kdota yio v molvtiun fonfeio mov pov
TPOCPEPAV KOTA TN SEPKELD VAOTTOINONG TG EPYACIOG [LOV.
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2ovoyn

Xe ot Vv TTuylakn epyocio Ba aoyoinBovpe pe T dnpiovpyio TPGOEGTATOV YPUPIKAOV,
Kol v €EEMEN Tovg o€ pia oA S100pacTIKY EQUPLOYT], dNAdN £V TTatyvidt.

Avaépovpe TEPIANTTIKG TapoOpow moryviole mov €yovv MON dnuiovpyndel, Kabobg Kot
dapopa Tpoypdupata Ta omoia eivatl KatdAANAa Yo oxed10GHO TALYVIOIDV.

Mo tov oyedoopd TV PackdV OVIIKEWEVOY B0 YPTOUYLOTOIGOVUE TNV EQOPLOYN
SketchUp, evd yia v dnpovpyia tov motyvidiod v epapuoyn Blender.

®a dovpe avolvTikd To epyaieia Kot TV 600 QPAPUOYDYV, TIG SLVATITNTES TOVS KAODS Kol TO
TAG LTOPOVV VO GLVEPYOUTTOVV.

Téhog Ba ypnoomomcovpe va SCript oe yYAdooa Python, péom g epappoyng Blender yua
) dnuovpyia Kivnong.
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Abstract

In this paper we will deal with the creation of three-dimensional graphics, and their
development in a simple interactive application, i.e. a game.

We summarize similar games that have already been created, and various programs which are
suitable for game design.

For the design of the basic objects will use the SketchUp software. For the development to a
game, we will use the Blender software.

We will examine the tools that both softwares have, their capabilities and how they can
cooperate.
Finally we will use a Python script, through the Blender software to give motion.
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1. EIZATQI'H

1.1 Tevika

To avtikeipevo pe 10 omoio AGYOANONKOUE OTNV TOPOVGO TTVYIOKY gpyocic, gival o
GYEOLOGLOG TPIOOIICTUTMY YPAPIKMOV KOl OT) CUVEXEWD 1) dMpovpyia evog moaryvidod pe Pdon to
LLOVTEAO TTOL PTIAENLLLE.

o vo vAoTomGovLE TO. TOPATAV® YPNGLOTOMGapE TG epappoyés SketchUp yuwr v
oyeodiaon tov Pacikol povtélov, Tave oto omoio Ba otnpiytel To moryviol. o ) dnpovpyio Tov
TS0 ypnolponotcape Ty popuoyr Blender.

1.2 Xxkomog

Apywd o okomog, MTav 1 Onpovpyic. €vOg TPIGOAGTATOV LOVTELOV, OEiyvovTog £T0L TIC
duvatdmreg tov SketchUp. Emedn opmg awtég givar meplopiopéves, 68 apyItEKTOVIKO Kot SOUIKO
eninedo, amopaciotnke vo e&elybel 10 poviélo, oe mayvidy, pe ™ Pondel ToL TPOYPAUPATOG
Blender.

1.3 Ileprypaon

To povtélo mov dNUIOVPYNGALE, AVOTAPIGTH EVa dWUATIO TO omtoio £xel Eva Tpoméll pe éva
evudpeio emdvo.

To moyvidlr Eekivd kdvovtag pion mAONYNON 61O OMUATIO KOl OTN GLVEXEW 1 OpAch
LETAPEPETOL LEGO GTO EVVOPELD, OOV O Ty TNG £XEL TN SLVATOTNTO VAL TAGEL TAL YAPLL TOV VILAPYOLV
péca og autd eite pe €vo KopdKL Tov ekto&evetal kabe gopd, gite pe éva aykiotpt. Yndpyet évag
UETPNTAG TOVTAV, KO Y10 KAOE Wapt oV TLdveToL o1 TOVTol O avEavovTotl KoTd Evay.

H mhonynon péoa kat €€ amd to evudpeio yiveton pe ) yprion tov tAnktpov W, S yio umpog
Kol wiow avtioTolya, Kot pe to movtikt oTtpifovpe de&d, apiotepd, mhveo Ko kKato. Tlatdviag to
aploTEPO KOLUTL TOV TOVTIKIOD EKTOEEVETOL TO KOUAKL, €VO WME TO TANKIPO TAV®, KAT®, Oe&ld,
aploTePd, A Kot Z KIVOOUE TO 0yKIoTPL.

1.4  Aopn

o Keopalmo 1: Evcoyoy

e  Kepdahimo 2: Video Games kot Game Engines
Avagépovpe ta video games avéioya pe tov TOTo toug kat i Game Engines mov to dnpiovpyovy.

o Kepdlaro 3: Awwdkacieg AvamtTong
AvoQopa oto epyaAeia TOL ¥PNCIUOTOMONKAY Kol 0vAAVGT TV J1001KAGIOV LOVTELOTOINGONG.

o Kepdlaro 4: Amoteréopato,
IMapovcialovpe Tovg TPOTOVG LE TOVEC OTOIOVE UTOPOVUE VO KAVOLUE OTOS0GT TOL Ty vidoh Kot
AVOQEPOVLE TO. GUUTEPAGLOTO, LLOG CYETIKA LE TNV OTOTELEGLOTIKOTITO TOV TPOYPUUUATOV.

o IMapdptnpa
SketchUp
Anpovpyio tov apykod poviédov oto SketchUp ko doxipdlovpue Too materials ko styles tov.
Import — Export
Tepapotildpaote pe v e&aymyn Tov poviédov amd to SketchUp kot v eicaywyn tov oto Blender,
€161 ®oTe Vo OlAEEovUE TIC KOTOAANAOTEPEG pubuicels, vy va €xovue v KaAHTEPT SuvaTy
LETAPOPE TOV HOVTELOL OO TN L0 EQAPUOYN OTNV GAAT.
Blender
YyeOlOoUOG TEPOITEPM OVTIKEWWEVODY Kol YpNHon Odpopwv Asrtovpyldv mov Swbétel ywoo mo
PEOMOTIKG amotedéouata. Anuovpyio Swdpoaotikotntag pe v unyovy Game Engine. Xpnon
YA®GGOG TpoypappoTicpuod Python.
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2. VIDEO GAMES KAI GAME ENGINES
2.1 FEwoayoy

“Eva video game givol éva MAexTpovikd matyvidl, to omoio cuvdvalel v aAAnAenidpacn
peta&d Tov avlpmmov Kot evOg TEPIPAAAOVTOG YPNOTT, MOTE Vo, dMovpyn el pia OnTIKN AvTOmTOKPIoT
og pio TNAEomTIKN 6VoKeLY. Ta NAEKTPOVIKG GLGTNIOTO TOL YPNGILOTOOVVTOL Yo To. Video games
ovopdlovior TAOTQOPLES, TETOWL GLGTIUOTO €VOL Ol TPOCMOTIKOL VTOAOYIGTEG KOl Ol KOVGOAES
TALYVIOIOV.

Me t0v OpO0 TAUTQPOMO OVAPEPOUONCTE GTOV GLVOLOCUO MAEKTPOVIK®OV e&opTnudtov n
hardware tov voAoyioti}, 6mov pali pe To Aoylopikd emtpémovy éva video game va Asttovpyfioet. 2
[TAéov ypnoyomoteitar emiong yio va SNAMGEL TNV NMAEKTPOVIKT LANPESIO EVTOG TG omoiag maileTol To
oy viol, mapdderypa 1 ceAida Kowvovikng diktowong “Facebook”.

O1 6VOKEVEG €GOS0V TOV YPNGLLOTOLOVVTOL YI0L TOV XEPIOUO TV Video games dtapépovv
aviAoyo pE TNV TAATPOPUO TOL XPNOlHoTOoLEiTaL, mapadsiypata givol ta xeiplotnpia, joysticks,
gamepads, TAnktpoAdyl0, TOVTIKL.

2.2 Eion video games
2.2.1 Ewoyoy

Ta video games yopilovtol o €161 avaroyo pe Tic peBOS0VE, TOLE GTOXOVE, TNV TEXVOTPOTIa,
NV OdPOoTIKOTNTA TOVG e ToV Talytn. Me v e£éMén rov% OU®G TaPATNPOVUE OTL TO. OTUEPIVA
video games givon pio picn tov Stdpopmv 8@V mov vdpyovy.

2.2.2 Eion ™

Ta Pacikd £i6n tov video games kat ot Kotnyopieg mov yopiloviol oivoviol 6TovV ToPaKATM
mivaxo.

Ta mo dadedopéva givor ta first person shooter wkau third person shooter mayvidio 6nwe to
Doom to omoio Pynke mpdTN Qopa og KukAopopia o 1993, uéypt kar o 2007 6mov KuKAOPOPNGE TO
Doom4 ka1 yTav first person shooter moyvidt emoTnUOVIKAG GavTaciog Kol TPOUOV.

To Call Of Duty mov fjtav xau first person kou third person shooter mov kvkhopdpnoe o 2003 kau giye
oav potifo tov B’ maykdopo moAepo, n etapeior Activision kvikhogoprice kol GAAeC GEPEG TOV
AL VIOo0 péxpt o 2014,

To Resident Evil exiong moryvidt tpopov, emBinong kot eavraciog, o 1996 evd kot puéypt to 2012 1
etopio Capcorm kvkAo@opovoe pia kavovplo £K60cT Tov, Kibe xpovo.

Emiong dwdedopéva givar ta moayvidt poiwv moAlamiwv ypnot@wv MMORPG, 6mmg 1o
World of Warcraft (WoW) g Blizzard Entertainment éva moyk6co motyvidl, OmTov ot moiKTeg
eléyyouv éva avatar yapaktipo Kol £XOVV OKOTO VO TOAEUNCOLY TEPATA KAl VO EEEPEVVIIGOLY TOTIA,
0AOKANPOVOVTOG OAPOPES ATOGTOAEC.

IMoyvidte MMORPG oAld xoir Real Time Strategy eivon to Warcraft ¢ Blizzard
Entertainment, 6rov ot avtinaiotl ToikTeg EAEYXOLV TOV YOPAKTNPA TOVG KOl SIVOLV EVTOAES HAYNG OE
EIKOVIKOVG 6TPOTOVC.

To mo yvootd moyvidl TPOCOUOIDONG TOL TPAYHOTIKOD Kdouov givar to The Sims, g
Electronic Arts. Kvikhopopnoe tov Prefdapn tov 2000 1 mpdtn oepd kot 1 tedevtaio tov Oktdppn
Tov 2013.

To Pro Evolution Soccer ¢ etapeiog Konami xai to FIFA Soccer tng Electronic Arts givol
T o d1donpo Sports game, émov TpocwUoLmVoLY Todocpalpikovg aymves. To Pro Evolution Soccer
KoK opopnoe Tpd™ Popd to 2001, evd to 2013 kvKhoedpnoe 1 terevtaio €kdoon tov. To FIFA
Soccer kvkAopdpnoe 1o 1993 kot 1o 2013 xukhoeopnoe to televtaio FIFA 14,
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Eion Katnyopieg
Fighting Maze Shooter
Mayn évav mpog €va, To 7edio eivar £vog Mdiyeg Omov GLUUETEXOVY OTTAQ KoL TUPADAOL
800 yapaxTipOV Xa[}ﬁpw@og ()nop First-person shooter [5]
Ty Sup_er Smash Bros, TPEMEL VOl 5[&6)(:10'81 0 QIO TNV OTTIKY YOVIK TOV XOPAKTIPO TOV EAEYYEL O TTALYTNG
Street Fighter 11, Mortal mafyT i ot maiytec, T, Doom, Call of Duty, Battlefield
Kombat £XOVTOG EUTOLNL KO -
1p6vo Third-person shooter
. IIy. Pac-Man OO L0l OTCTIKT Y@Vio 6070V 0 7oy Tng PAETEL 0o TG® TOV XOPaKTHPL
Action ITy. Resident Evil 4, Mass Effect, Grand Theft Auto
Shoot 'em up
moikTng EAEYYEL Evay YopakTipa 1 dympo Kot TopoPfolet peyddo aplOpd twv
gxOpav, arcade moyvidio
MMO FPS
Avapuén tov fps pe to moyvidio toAhomddv xpnotdv. Zuvibog givar mayvidio
7oL aifovTat 6To J10dikTLO, e TaiKTES Ao OGAOV TOV KOGUO, TOL
GUVAVTIOOVTOL GE EVOV EIKOVIKO
Real-time 3D Text adventures | Graphic Visual novels
adventures SradpaocTtikn adventures A08paoTiKd Toyvidia QavTaciog 1e GTOTIKG YPaEUkd kot
Adventure 3D mayvidio v povbomiacio pe EEEMEN TOV ouvfmg gnime GTUA, T0. 0TTOi0. LOLGCOVV e
akolovBovv Tovg EVTOAEG Ao TO TPONYOVUEVOL, LE woboopripota
PLGIKOVG VOHOLG mnKTporoylo dadpaoTikdTnTOL
UEC® MOVTIKIOL
Role- Western RPGs Use of fantasy | MMORPGs [
p|ay| ng and Japanese in RPGs Mién tov toyvidiov modlaridv moyytdv pe RP Games. Taikteg oo 6Ao tov
O noiktne RPGs T QOVTAOTIKG T KOOpHO avoAapBavouy KAToloV XopaKTp Kot 0AANAETSpoOv peta&h Toug péoa
., o - . G¢€ £V0, EIKOVIKO KOGLLO. o
zgi";x‘;:; ﬁ‘; 0 | Me Baon mv :g;g’;gg:m Iy. World of Warcraft (WoW), Star Wars: The Old Republic, Final Fantasy

Baon éva
npokadopiopévo
oeVapLo

OLUEPTKAVIKT KoL
OTOVIKT KOVATOVPOL

X1, The Lord of the Rings Online

Simulation

AVOTTOPACTOOT TPOYLOTIKOTNTOG 1] TAUGHOTIKG TPOYHOTIKOTNTOS, TOAEW®V KOl ovOpdT®mV mov {oOv 6€ anTéG, TNV KaONepvOTTO TOVG, 1] avoapdoTocn
03N YNONG HETAPOPIKDV LECMV OO AEPOTAGVOV KOL TPEVAV

ny. The Sims
4X game Artillery game Real-time strategy
OTPOTNYIKNG pe 4 Hoyvidwa 2 -3 moytdv | Ot moikTeg TPETEL VO TAPOVV ATOPAGELS KOt VO, SpAGOLV, 0G0 TO T Vidt
Strate Baoticovg otdy0Vg 6mov divouv pdyeg e&elioeTon
gy eXplore, eXpand, ITy. Warcraft series, Age of Empires series, Dawn of War, Command and
eXploit and eXterminate Conquer
Racing Sports game
SpO rts AvomapocTacelg Avanopdotaotn S1épopmv oTop
AYOVOV ToOTNTOG ITy. FIFA Soccer, Pro Evolution Soccer
Music Puzzle Trivia Casual
Other IIy. Guitar Hero ITy. Tetris Moayvidio AmAG Tonyvidio wov amevbivovtar oe Eva paliko Koo
YVOCEDV [y. Mahjong, vapxaligvtiig, maciévéa
Exergame Educational Art Casual | Serious
IIy. Wii Fit TMouyvidio oyedacpéva yio ekmaidevon,
By purpose GLVVOL, ETIGTNLLOVIKT EPEVVE, VYELOVOLKT

nepibolyn, Swyeipion kvdvvov, Bpnokeia
TIpocopotdoELS TOV TPAYHATIKOD KOGLOV,
N moyvidw pehddov

2.3

2.3.1

Eion kol katnyopisc T®v VIDEO games t
3D mwpoypappota
Ewsayoyn

Mo game engine givol évo cOoTnpo oYedloopuévo va dnpovpyel kot va avortdocel Video

games. Ot KopuQaieg UNYOVEG TALXVIOIDV TOPEYOVV £VOL TAAICIO AOYICUIKOD OV XPTCLUOTOIEITAL OO
TPOYPOUUATIOTEC Y10, VO ONUIOVPYNCOLY  TOLYVIOW, Yot TPOCOTIKOVS VTOAOYIOTEG, KOVOOAEC
T VIOV, Kvntd mAépmva. H Bactkr] ASTovpytkotnTo OV TUMIKA TPOEPYETAL OO 10, HUNYOVY
TALYVIOO0 TTEPIAOUPAVEL v UNYOVICUO atOd00NG Yo d1odIIoTOT 1] TPIOOAcTATO YPOPIKA, Lo
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UNYXOvV TPOCMOUOI®ONG  QUOIKAOV KOTUOTACE®MY M UNYOVH] aviyvevong oVYKPOVLONS, TEXVNTH
vonpocivT, 130, scripting, animation, diktowon, streaming, threading ko ypdonuo oxnvic.

Ot unyavég TPIGAAoTUTOV YPUPIKOV 1) T0. GCLGTHLOTO 0T0d0cT g TovS, cuvibwg Pacilovtol o
éva TepPEALov Tpoypappotiopod ypopkdv (API), 6mog to Direct3d 1 to OpenGL."!

2.3.2 Game Engines

. Unreal Engine ™!

Avantdydnke amo v and v Epic Games. EpgaviCetar mpdtn @opd pe to opdvopo first person
shooter mayvidlr to 1998. IMapdt eiye oyedaotel yo yioo FPS mayvidwa, éxet ypnoyomombel pe
emttvyio kow e MMORPG kot RPG mayvidw. Ipappévn oe C++ dabéter vynAd Babud eopntdtrag
KOl GNLEPO XPTOLUOTOIEITAL OTTO TOAAOVG TPOYPUUUOTIOTES.

H tpéyovoa ékdoon tov eivor  Unreal Engine 3 1 onoia exet oyediaotel yio Windows kot Xbox 360,
Windows Vista, Windows 7, Linux, PlayStation 3, Wii U, ka1 i0OS, yia Android, yio to Adobe Flash
Player 11 kot yio HTMLS.

‘Exet ypnowonombei yia to moadikd TV show LazyTown, kabobg kot yo to mwoaryviowe Unreal (FPS),
Mass Effect (Action role-playing, third-person shooter), Medal of Honor: Airborne (FPS), Star Trek:
Deep Space Nine: The Fallen (Third Person Shooter, Adventure), Sephiroth (MMORPG).

. Doom ¥

O mnyaiog kddwag yuo v ékdoorn Linux tov Doom kvkAopdpnoe oto kowd otig 23 Askepufpiov
1997. Apyotepa enavaxvkhoeopnoe vro v GNU General Public License, 1o 1999.

IMoporo mov M pnyavh amodidel &va TPIOdACTUTO YDPO, OVTOG O YMPOG TPOoPdAetal amo pio
dwedidotatn katoyn. H punyavr Doom apyotepa petovopdotke og id Tech 1 yuo va ptdoel onpepa
oto id Tech 4.

To id Tech 4 eivon ypoupévo oe ylwooa C++. Ymoompiler bump mapping,normal mapping,
kou specular highlighting, duvapukd eé, skeletal animation. Awféter MegaTexture teyvoloyia
andd0oNG, YAOGGO TPOYPOUUATIGHOD Yo, SCripting mapdpowa pe v CH+, vrootmpiler Myo kot
ypnoonotei To povréro client—server.

IMouyvidio wov £xovv dnpovpynBei eivar to. Doom, Doom II, Final Doom, Doom3.

. Anvil 1

Anovpyndnke to 2007 amo v etaipéla Tpoypappaticpod video game, Ubisoft Montreal yua va
ypnoonoteitan amo ta Microsoft Windows, PlayStation 3, Xbox 360, Wii U, PlayStation Vita, Xbox
One, kot PlayStation 4. Xopeova ue tov Claude Langlais, n povighomoinon tov mepifdiioviog
yiveton oto 3ds Max kot kou 6t0 ZBrush yio Tovg yopaktipec.

[Moayvido mov éovv dnuiovpyndei: Assassin's Creed Il, Prince of Persia: The Forgotten Sands,
Assassin's Creed: Brotherhood, Assassin's Creed: Revelations.

. Crystal_Tools 1**

Yuvovalel mpdtumeg PiPAtobnKeS Yio oToLElR OTMG YPOPIKE, YO KoL TEXVNTI VONLOGHVT], KOl TOPEYEL
GTOVG TPOYPOLUOTICTEG Tony VISV dldpopa epyareia cuyypaenc. Ot otdyot g givon to PlayStation
3, 10 Xbox 360, 1 Microsoft Windows kot to Wii.

Yuvovalel tomikég PipAlotnkeg yio ™V omddoon TOV YPOUPIKGOV , €TeEEPYaciag QUOIKNG , EAEYYOG
Kivnong , KWnUOTOypOaeIKd , OTTIKG EQE , OV , TEYVNTN VONUOGUVN Kot TN dtktvmon. [lepthapPdvet
éva mpoypappo mpoPoing yopaxtipwv yw 3D povtéla, Yo KOWIHO OKNVOV, €pydAeio mpo-
OTTIKOTOIONG, Kot Onuovpyiag Nyov. H Xpnon tpitov mpoypapudtov ommg Autodesk Maya,
Autodesk Softimage ka1 to Adobe Photoshop vmootpileton péow plug-ins.

Hoyviow: Final Fantasy X111, Final Fantasy Versus XlI1, Final Fantasy XIV, Final Fantasy XII-2.

. Panda3D [

Elvar pe  unyovy omuovpyiog  ypoeikov oknvig, mepthapufdvel  ypoeikd, Myo, ocOoTUo
£106000/e£0600V, aviyvevorn cOyKpovong Kot GALEC 1010t TEg OV YpetdlovTor Yo TN onwovpyia 3D.
Elvar éva ekevbepo Aoyiopikd avorytod kmdwka. H mpotiBépevn yAdooa yw v avamtvén tov
Ty violov ewval 1 python. H unyovn ewvaun ypapuevn o C++.
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‘Exetr un ypoouéc duvatotnteg ol onoieg eivat: Epyaieia avdivong anddoong, Epyaieia e&epedvnong
ypapnuatog, Epyaieio d10pbmong cpoipdtmv, tpiodidotatog fxoc, Mnyavn duvaukav, Yrootnpién
GLOKEVMV €16000V/E0d0V, Teyvntn vonuocvv.

‘Exetl xpnowpomombei yia tpiodidotata Ospotikd napka g Disney kot otn dnpovpyio moryvididv,
v 0 devtepo MMORPG, Pirates of the Caribbean Online.

. Maya 1**!

Eivar Loyiopikd yio tpiedidotata ypopikd vroloylotov mov tpéxel oe Windows, Mac OS xot Linux,
avantoyOnke apywd and Alias Systems Corporation kot €mi ToVv TOPOVTOG OVIKEL Kot ovamtiyOnke
a6 v Autodesk, Inc. Xpnowwomoteiton yw T dnuovpyio SadpacTtiKOV epappoydv 3D,
GUUTEPTAOUPOVOUEVODY TOV PVTEOTALYVIOIDVY, TAIVIEG KIVOLUEV®V GYESI®V, TNAEOTTIKEG GEPEG Kol
OTTIKG EQE.

2V0TATIKA: EPE VYPOV, PODY®V, YOUVAS, TPLYDV

‘Exet ypnowomomnfel vy T Onuiovpyic YpOoQIKOV Yoo TOAAEG  KIVIUOTOYPOQIKEG  TOLVIES,
ocvpmeptrappavouévev tov «To Kopitor pe 1o Tatovdl», «Avatar (2009)», «Wayvovtag tov Néuoy,
«Up», «Monsters», emiong, ypnolomoteitor Yoo TN Onpovpyic ONTIKOV &PE Yoo TNAEOMTIKE
mpoypappata, 0nmg to «Game of Thrones», «The Walking Dead», «Once Upon a Time», «Bonesy,
«Futuramay, «Boardwalk Empire» kot «South Parky.

SUUUETEIYE OTN dNUIOLPYIL TOV OTTIKAOV €QE Yia frvTeomaryvidia, coprneptropufavouévov Halo 4.

[16]

o Unity
Ewaon puo cross-platform game engine pe evoopatopévo IDE. avartoydnke and Unity Technologies.
ypNoLonoteital yloo tnv avamtuén video games yio web plugins, miatpopueg desktop, kKoveoreg Kot
POPNTEC GLOKEVEG,.

[Ipog to mapdv vrootnpilel v avamtvén ywo i0S, Android, Windows, BlackBerry 10, OS X, Linux,
web browsers, Flash, PlayStation 3, PlayStation Vita, Xbox 360, Windows Phone 8, kot to Wii U.
XopaKTnploTikd:

Rendering: H pnyovy| ypaoikov ypnotponolel Direct3D (Windows , Xbox 360 ) , OpenGL ( Mac ,
Windows, Linux ) , OpenGL ES ( Android , iOS ) , kot dwoxtnteg API ( koveoreg ). Ymbpyet
vrootypiEn ywo. T ump mapping, reflection mapping, parallax mapping, screen space ambient
occlusion (SSAOQO), dynamic shadows pe shadow maps, render-to-texture xou full-screen post-
processing effects. Yrootmpiler otoyeia kot popeég apyeiov amd to 3ds Max, Maya, Softimage,
Blender, Modo, ZBrush, Cinema 4D, Cheetah3D, Adobe Photoshop, Adobe Fireworks, to omoia
umopovv va tpootefodv 6to TPoTleKT TOV TAVISOD Kal Vo dlayelpiotovy. H yAdooa ShaderLab
ypnowonoteitan yuo shaders , vmootpifovrag 1060 MNAMTIKY "TPOYPAUUATIGHOD" TV TPOYPOUUATOV
oV aywyol otabepr|g Asttovpyiag kot shader ypappévo og GLSL 1 Cg.

Scripting, Asset Tracking, TToAaniég mhateopues, Pvotkoi vopot.

[Mavyvidio mov £xovv dnovpyndei: Gone Home (first-person interactive story adventure video game),
Game of Thrones: Seven Kingdoms (fantasy MMORPG ).

. JmonkeyEngine ™"

DTidytnre 0K Yoo TN GOYYPOVN TPIOOICTOTN OVATTLEN, KOOMG YPNOWOTOIEL EKTEVAOG TNV
teyvoroyia shader. Eivan ypappuévo amoxieiotikd o€ Java kot ypnowyomotei Lightweight Java Game
Library wc¢ tnv mpoemleypévn Aettovpyia omddoong tov. Xpnolponoleital amd S1dpopa StopnUoTikd
GTOVVTIO TToyVidmV Kol To ekmandevTikd Wpodpota. To emionuo jMonkeyEngine 3 SDK givai éva
TePPAALOV avATTVUENG T VSO0 VYNAOTEPOL EMMESOV, UE TOAAATAL Ypoewkd ototyeia. To SDK
Baciletar oty TAatedpua NetBeans, enttpénovtog eneepyaotés ypapik®my kot duvatotnteg plugin.
Moyviow: Chaos (fantasy RPG), Drohtin (RTS) ingleplayer/Multiplayer.

. IW_Engine [

Avortoynke omd v Infinity Ward yio ™ onovpyia g oepdag moryvidiov Call of Duty. Eivou
WKt pe TV ovumepiinyn tov mpoypduppatog GtkRadiant amo v id Software. 'Eyet
ypnooromBei and v Infinity Ward, Treyarch, Raven Software kou Sledgehammer Games.

. Blender Game Engine

Eivaw éva e&dptnua tov Blender, evog elévbBepov Aoyiopukdy ovolktod KmdOKe Kot piog
0AOKANPOUEVC COVITOG TPIGOACTATNG TUPAYWOYNG, 7OV  YPTNOLUOTOIEITOL Y10, TNV KOTOOKELT|
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S10dPOCTIKOD TEPLEYOUEVOL GE TTPaYUATIKO ¥podvo. H pnyovi) Tov mayvidod ypdetnke amd to pndév
og C++ ko epriapfavel vrootnpign yia Asttovpyieg 0mmg 1 Python scripting kot OpenAL 3D nyo.
Xpnowonotel éva cvotnuo ypapikev logic bricks yio va eAéyyel v kivinon Kol Ty omEKOVIoT TOV
OVTIKEWEVOV OTNV pnyavr], uropet eniong va enektobel péow g Python.

Sounepthopfavel aviyvevorn ocOYKPOLONG KOl TPOGOUOIMOT SUVOUIKTG, TOTOVS GYNUATOV, OTMG
oQaipa, KOUTL, KAT, TANPN VTooTNPIEN Yo TN SUVOIKT OYNUaTOG. Yoot pilele A0V TOVG TPOTOVS
ootiopod OpenGLTM , cvumepthopfavopéveoy tov SoQaveldy, oVTIGTOlYIoN VOOV, VIOGTHPIEN
TOALOTADY VYAV, YOPTOYPOPT|GT], AVATAPAYDYT] TALXVIOLDV, Kol TPIGOIGTOTO 1)O.

Xpnowonomnke otnv touvie SpiderMan?2 ko og ekmopnég tov History Channel.

[Moavyvidw: Yo Frankie! (third person shooter).

. CryEngine !

‘Exel oxedaotel amo v yeppavikn etaupio mpoypoppaticpot mayvidiov Crytek. H mpotn ékdoon
¢ 1 CryEngine 1, ypnoporombnke yia to FPS mayvidt Far Cry, ka1 to MMORPG, Aion: the tower
of eternity. Mg tv CryEngine2, oyxedidotnke to Crysis FPS mayvidt. Me v 3 1o Crysis 1,2,3 yo
Microsoft Windows,PlayStation 3, Xbox 360, kot to Warface, avapéveror n 4" yevid.

Kdanow omo to yopokmnplotikd tng elvar ypaonuo pons, emeepyacstis LAKOD, OAOKANP®UEVO
ovoTNHO KAALYNG €3GQove kol PAAoTNONG €pyoAEion Yo OMUIOLPYIO TOTAUMV Kol OpOUMV,
onuovpyio oyNUATOV, TANP®G EVEAIKTO GUGTNUO TMUEPAG, OULVEYNG POTN, CGVGTNUO, OTTIKOV
TPOVTOAOYIGLOV, VIOGTAPIEN TOAVL-TOPNVOL eNelepyaoTr, amddoor eKTOC GUVOESNG, HETOYAMTTION
TOPWV, SUVOUIKOC COUPIKOS POTIGUOC GE TPUYUATIKO ¥POVO, TPIGOIAGTATO VEPO DVYNANG TTO0TNTAG,
amO00GT VPTG G€ LYNAN ToOTNTA, SVVOAULKOL YOl Kot SIOdPACTIKT LOVGIKT, YOl TEPIPAAAOVTOC,.
[Mavyvidw: Crysis.

. 3D Studio Max Y

[poypappor  dnpovpylog TPIOOEACTATOV  YPAPIK®Y, KIVOUUEVOV OYedi®V, HOVTEAMD, ELKOVEG.
AnpovpynOnke kor avantoybnke omd v Autodesk Media and Entertainment. 'Eyel duvototnteg
LOVTEAOTTOINOTG, Lo EDEAKTT apyLTEKTOVIKY| plugin kou pmopel va ypnopomombel yio v miatdppa
Microsoft Windows. Xvyvd ypnoyromoteitor amd toug oyedlacTéS Totyvidumy Pivieo, amo TNALOTTIKA
otovvtio. H televtaio ékdoon tov 3ds Max dwwbétel emiong shaders, duvaukn mpocopoinon, to
cvoThpote copatdiny, radiosity, Kavovikn dnuovpyio ¥4ptn Kot 0mddoon Kabokod pOTIGHOV, £va.
TPOCAPUOGIHO TEPPEALOV Epyaciog ¥pNoTN, KoL TN O1KT TOL YAMGGO scripting.

Xopoaktnpiktikd: scripting yAdooa v MAXScript, kivinon ewovik@v yapoktipov, e&gpebvnon
oknvne, sloaymy DWG  apyeiov, mpocdiopiopog kot emefepyocio veav, yevikd keyframing,
egavaykootikd animation peto&d Svo avtikepévov, Skinning, okeleroi kou kivmon (inverse
kinematics (IK)), unyavn avarnapdotacng évovongc, olokAnpmon pe to Autodesk Vault.

To Avatar ypnouonomoe ypagikd tov 3ds_Max.

Xpnoyonoteitol yio TplodidoTtoTe ypopikd yio Videogames.
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2.4  Fishtank
24.1 Ileprypapn

To mayvidl g mTVYOKNG epyaciog, avamaploTd &va gvudpelo PECO GTO OTOI0 VTAPYOLV
yapla. O okomdg Tov mayvidod givar va macovpe to yapla kot va poaléyovpe moévrovs. o kabe
YapL avTioTolyel Kot Evag movtog. Yapyovv 600 TPOTOL WAPEUNTOS O TPMTOG EVOL PE EVO KOUAKL
OV TMETAUE 6TO YapL mov BEAovpe va mdocovpe Kot 0 dgVTEPOG givar pe éva aykiotpt mov PpiokeTon
HEGQ OTN YLUOAQ KO TO OTTO{0 KIVOUUE (DOTE Vo oyYiEel KATOW0 Wapt.

Zav evIolég €16000V, £YEl TO TOVTIKL Kal To TANKTPoAOYo. H kdpepa 1 omoion Guvodedel To
KOPAKL Kveitonw Pmpootd Kot wicwm pe tn ypnomn tov tinktpov W kot S, eve otpifel mpog orec Tig
KkatevBovoelg pe v kivinorn tov movtikov. To aykiotpt 1o omoio @aiverar pe pio devtepn Kapepa,
Kveital pe to «PBeAaKioy Tov TANKTpoAoyiov Kot e Ta A kot Z.

Ta mpoypAupaTo TOV YPNOWOTOWONKAY Yoo TNV dnuovpyic. Tov maLVIdL, &gival To
SketchUp kot to Blender, evé yua v ene€epyacia tmv eikovev ypnotporomdnke to Photoshop.

To moayvidl pmopei va yapaktmpiotei wg first person shooter, &€ ottiag Tov KopakloH 1OV
neTape, oALd ka1 ¢ éva Real Time tpiodidotato matyviot.

24.2 X601

Apyicd 0 oTOX0C NG gpyuciog, NTAV O GYESIOGUOG EVOC TPIGOIICTOOTOV LOVIEAOL LE TO
SketchUp. Xt ovvéyelo PAémovtag g OuVOTOTNTEG TOL TPOYPAUUOTOS, OTOPAGIOTNKE VL
dnuovpyndet to apykd pépog oto SketchUp kot to voAouto og Kamowo GAAY €Qapuoyn oyedioong
prodidotatov ypapikdv. H debtepn epapuoyn mov ypnoonomoape sivar to Blender kot o Adyog
oV SlaAéyOnKke gival yuo va SoOE TIG SuVATOTNTEG TOV GTOV TPLGIAGTATO GYEOLAGO.

O oxomog péypt tote MTav vo eTIoyTel Eva evodpio, £T61 doTE v dovUE TOGO peoAoTiKa Ba
umopovoe va amodobel vag KOGHOG KAT® OmO TO VEPO KOOMG KOl 1 OVATOPAGTOCT TOV QUGIKMOV
KOTOOTACEDY TV OVTIKEIUEVDV.

2T OULVEXEWDL Y10 VO OMOKTNGEL TEPIGCOTEPO EVOWIPEPOV 1) EPYOCIQ, OMOPAGIGOUE VO
g€elM&ovpe TO TOOOAOTOTO HOVTEAO GE €VOL TTOVIOL KOl £TGL EMITAEOV VO £YOVUE TNV gvKalpio va
AVOKOADWOLLE TIG IkavoTnTeg Tov Blender 1660 otov oyediacpd, 660 Kot 6T Snuiovpyia oy vidiov.
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3. AIAAIKAXIEX ANAIITYEHX
3.1 Ewayoyn

Apywkd ypnowonomnke to SketchUp, ywo v e€dkodn ypnon tov o610 GYESAGUO
TPLEOACTATOV HOVIEA®V KOl Ylo. vo dovue Tig duvatotntég tov. Kabmg ouwmg eivar kabopd éva
TPOYPOLLO Y10 OPYLTEKTOVIKO GYESGUD, OMOPUGIOTNKE VO TO GUVOLAGOVUE KOl UE Eva OEVTEPO
TPOYPOLLLLAL.

To devtepo mpdypoupo eivor to Blender, to omoio eivor katdAAnio Yo cyedOGUO
TPLEOLAGTATOV HOVTEA®MY, OAAG KOl Yio TN Onpovpyia S1adpacTik®v epappoyav. Emiong 0élape va
SoVE TIG SLVOTOTNTES TNG EPAPUOYNG QTG KAOADS Kot TNV VKOAlL 0T ¥PNoN KOl TNV KoTavono
g,

3.2 Epyoieio
3.2.1 SketchUp

3.2.1.1 Ewayoyq

To SketchUp eivar évo eledBepo Aoylopikd yio TPIoOIAGTATO GYESGUO OVTIKELUEVOV.
XPNOWOTOLEITOL KUPIME Y10 PYLTEKTOVIKA Ko unyavikd oyéota. ‘Eywe droktnoio tg Google and 1o
2006-2012 o amd to 2012 péypr ko onuepa o Exel avaidPer n etapeio Trimble Navigation, n
omoia aoyoAeital Le yopTOYPAONON, XOPOUETPNOT Kol EE0TMG OV TAOTYNOTG.

To mpdypapupa eivor ebypnoto kot drabétet pio niextpovikn amobnkn v 3D Warehous n
omoia £yel £Toa TPIGOACTOTA HOVTELD £TG1 MOTE 0 KABE YpNoTng va pumopel va ta Katefdost Kot va.
T ypnoponoostl. Eniong to poviéha mov dnpovpyovvrar oto SketchUp, uropodv va torobetnbodv
oto Google Earth.

Ortav to SketchUp dvnke oty Google, dnpovpyndnke o £€kdoon tov, 1 omoio NTo dmpedy
Kol pmopovoe va v KoatePdost kdbe ypnomc. Abete ohokAnpopéva gpyaieio dote vo avePalet
nepleyopeva oto Google Earth kot oto Google 3D Warehouse. Anpiovpyndnke po véa gpyoaietodnim
wote 0 ypNotng va umopel va PAEnel to mepiPdiiov tov SketchUp and ) okomid Tov Tporyotikon
koopov. Emiong m dwpedv éxdoon umopei va e&dyel opyele pe ™ popon tov .dae, .kmz,

.3ds, .dwg, .dxf, .fox, .obj, .xsi, and .wrl apyeiov. Mropei va kavel render eikdveg pe Tig KOTOANEELS
.bmp, .png, .jpg, tif.

Y7o v Trimble dgv vrdpyovv dapopic yia v dwpedv €kdoor tov SketchUp. To SketchUp
Pro anoktd mopamdve duvaTdTnTeS OTTMG KOADTEPA epyaieia Kot duvatdtnta eaywyng Pivieo vyning
avaALOTC.

To SketchUp £yet epappoyf] otV apyltekToviky, Unyovoioyia, otn dnpovpylo @AW, TOV
GYEOLOGLO TTOLYVIOLDV KOl GTNV TPLOOAGTATY EKTOTWOOT).

e (23]

3.2.1.2 Iyedroopoc pacucod oyediov

To avtikeipeva mov eTiaéape pe to SketchUp givan to tpoaméll, to evudpeio kot 1 Bdon Tov
Kol T0 dwudtio 6Tov VIApYoLY OAa avtd. [ T dnpovpyicl TOVS YPNCYLOTON|CAUE TO. EPYOAELD
oyedlacpod kot Tpomonoinong mov dwbétel To SketchUp *. Tove mpocbéscapie Sidpopa materials ko
styles, mov d1aB£TEL 1] EQAPLOYT KAt KAVOLE SOKLLEC Y10L TO TS Tatptdlovy Thve oTo avTikeipeva .
To tehkd amotéleopa eival aVToO TG EIKOVOC.
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© @ Drag in direction fo Measurements

Ewova 1 - Tehko anotéleopa amo to SketchUp

3.2.2 Import — Export
3.2.2.1 Ewayoy

I va propécovpe va cuveyicovpe v eneepyosia tov poviéhov oto Blender, mpénet vo, 10
g€ayovpe amo to SketchUp oe pio popen apyeiov mn omoiot va ypnoipomoleitor kot omo o 600
npoypappate. H popen avt sivan n enéktaon apyeiov .dae, n onoia tavtiCeton pe ta apysio Collada.

Onwg eoivetar 610 TapapTuo >° KEvovpe SOKIUES TAVGD 6TO HOVTEAD Y10 SOVHE ME TOLEC
VEEG KO GTOA UTOPOVLE VO EYOVUE TO KAADTEPO amoTéEAES U OTAY TO El0dyovue oto Blender.

3.2.2.2 Collada

To Collada (Collaborative Design Activity) gival o, GuvepyoTiKy] SpacTnPLOTTO GYESAGUOD
v T Oéomion Mg UOPPNG OVIOAAQYNG OpYEi®V Yo OldPOCTIKEG TPLGOIAGTATEG EQPAPUOYEG.
Awyepileton amd tov dpho Khronos ! o pm kepdookomuchi Bropmyavio teyvoloyio.

H Collada opilet éva avoytd mpdtumo oyue XML yio v avtoalhoyn yneoKov oToryeinv
UETAED TV S10pOPOY AOYIGUIKOV EPAPUOYNG YPOPIKDV, TOL UTOPEL Vo, amonkedoetl Ta GAAL TOVG
otolyeia o pun ocvpPatéc popeéc apyeiov. Ta &yypaeo Collada mov meprypdpovv ynoeakd otolyeia,
elvar apyeio XML ko ovviBog tavtilovion pe v enéktaocn apyeiov .dae ( digital asset exchange).

Eivar 10 mpdto Aoyiopkd aveEaptiton TAaT@Opuac, to onoio opilel mpdtuma okicong Kot
e@é ypoppévo oe XML. Amevfovetar oe cuotiuata ta omoio tpéxovy OpenGL Shading Language ¥
OAAG KOl GE GUOTHUATO TEPLOPICUEVOV TOP®V. (6]

H teyvoloyia Collada emikevipdvetar 6Tov TOpEN TNG WYOXOY®YING, OOV TO TEPIEYOUEVO Eivor
TPLeo1acTATO Kot cuVNOmG givar éva onyvidtl. Yroompilel OAa To apaKTnpioTikd mov ypetdlovtal ot
VEEG TPLOOIAOTATEG EQOPLOYESG YO VO AVTAAAAEOVY Kot Vo, S1o@LAGEOLY TAPMG TO aToryeia Tovg. Ot
SUVATOTNTEG TNG EMEKTEIVOVIOL MOTE VO, EVOMUUTMOEL TEYVOLOYiEG, OGS Ta TPOYPAUUATILONEVD EQE
OKI0G KOl TOV EAEYYO UNYOVAOY QUGIKNG TPAYLLATIKOD XPOVOV.

Qo160 dev gival amAd uio teyvoroyio. ‘Exel xataeépel va mpoceépel pa ovoétepn (dvn,
OTOVL Ol OVTAYMVIOTIKEG €TALPElEG cuvepyalovtal Yo TNV avanTuén Kowvav mpodiaypapodv. Mropel
emiong vo emektadel amd TOVG TEMKOVG YPNOTEG AVAAOYO LUE TOVG GKOTOVE TTOV HELOVV VO, TTETVYOLV.

H gmloyn thg XML cav yAdooa tng Collada, £yve yio va ekueTahAenTOV TO TAEOVEKTHLLOTOL
g, ovumeptAapufavopévng kat tng debvoug kmdukoroinong UTF-8.
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To Collada vmootpiletar omd Sdpopo  Aoywoukd dnuovpyiag diodidotatov 1
TPLEOLAGTATOV YPAPIKOV, KAODC Kol 00 UNyovEG Tty vididv. Mepikd amo ovtd givat:

Photoshop ¢ Adobe

3DS Max g Autodesk

Maya g Autodesk

AutoCAD g Autodesk
SketchUp ¢ Trimble Navigation
Google Earth g Google
Blender tng Blender Foundation
Unity tc Unity Technologies
Panda 3D tng Disney

Cry Engine 2 g Crytek

Unreal Engine ¢ Epic Games

3.2.2.3 Xvoumepaopato.

Amo Tig Sokuég mov £xovpe kavel oto mapdptua ', BAémovpe Ott Tar YpdpaTe TOVL PALovps
010 povtéro and 1o SketchUp gpeaviCovrar kot oto Blender kou oto Solid kot oto Texture Mode, evi
ta Textures mov Palovpe gueaviCovrar povo oto Texture Mode cwotd. H yeouetpia kot o1 oKpég
epeaviCovron ko oto Blender. Ot axpég pdhota givor n povn emdoyn and to. Edge Styles n omoia
eaivetar oto Blender. Amo tig emoyég Face Style xouia dev petagépetar katd v eéaymyn, 0nmg
Kot ot emhoyég Shadow ko Fog.

Metd omd T1g doKHEG OV EYVOV TTOPATAV®, O TOLOG EVKOAOG TPOTOG VO YEPLOTOVUE TO
povtého pe to Blender givon to kévovue Export amd to SketchUp, Balovtog povo ven ot yudia kot
GTOVG TOLYOVG TOV “OUATION” £TCL MOTE VO, UTOPOVUE VO dOVAEYOVUE UE TO, PacIKO avTiKEipeVa
0AOKAN PO KO OYL SLOCTOGUEVE GE VTTO-OVTIKEIUEVAL.
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3.2.3 Blender

3.2.3.1 Ewayoyq ?"!

To Blender givar éva €Aedbepo AOYIGHIKO OVOIKTOD K®OOIKO, Y10 TPIGOUGTUTO YPUPIKE
vroloylotr). Xpnotponoweitar yio ) Snuovpyio TOVIOV HE KIVOUUEVO GYEOLD, OMTIKA EQE,
TPLEOLACTATY] EKTUTTMGN LOVIEA®V, JUOPOCTIKOV TPIGOACTUTOV EQUPLOYOV Kol BIVTEO-TOLVIOIDV.
270, YOPAKTNPIOTIKA TOL TEPAapPdvovtal 0 TPLodidototoc oyxedaopdg, to UV unwrapping, n
dnpovpyio vE®V, AVATAPACTOCT] KATVOD, DYPOV, COUATIOIMV KOl LOAOKADV OVTIKELEV®V, YALTTIKY,
kivnon, Kapepa mapakorovlnonge, amddoon oe TpaypoTikd Kocuo, eneepyacio kol ovvheon Piveo.
Emiong OSwbétel evoopotopévn unyovy onpovpyiag  moyvidolov  Kobmg kot TN YAdooo
npoypoppaticpov Python yio ecotepiid scripting.

Eivot draBéotpo yia 6ha ta kOpla Aettovpykd cvotipata énmg to Windows g Microsoft, ta
Linux kot to Mac OS X.

"Exel ypnoomomBel apyikd yio Kivodueva ox£010 Kol Tpo-0meEIKovIGeL Yo v Tawvio Spider-
Man 2. Eziong ywo eknounég tov History Channel, kafobg kat yia Stapnunotikd tmiedpaong og xdpeg
omwg N Avatpolia, Iohavdia, Bpalilio, Poooia kot Zoundia.

Yxeddv Kkabe ypovo to idpvpe Blender avokowdvel kdmolo kawvovplo project. To 2006
TOPOVGIACTNKE 1 Tovia Kivoupévav oyediov pukpov punqkovg Elephants Dream, to 2008 n Big Buck
Bunny, to 2010 n Sintel kot o 2012 1 Tears of Steel. Evd 1o 2008 dnpiovpyndnie kot avakovodnke
70 TplodidloToTo Totyviol Yo Frankie.

3.2.3.2 Xpnon

Ao¥ giodyovpe o poviédo oto Blender °, Eexwvape va to emefepyaldpocte mhéov cov
monyvidt >, ypnowonotdvrog v pmyovii Game Engine mov Stafétet.

Anpovpyodpe pe o epyoeio Tov Blender *°, to éEtpor avTikeipievo mov Ha PELAGTOVY Y10 T
dnuovpyia Tov TEPPEALOVTOC HEGH 6TO EVLSPIO *°, OTOC TO GTPGLA TG GUUOV, TNV ETLPAVELL TOV
VvEPOV, TO AYKIGTPL, TO PUKLN Kot TO Kopdkt. Kdmolo dAha avTikeieva 0Tmg To Wapla, Kot To TAoL0, Ta
épovpe kortefdoel amo v oehido Turbosquid . Emione &yovpe ypnowomomost Aaumec yia o
OOTIGUO TNG OKNVIAG KOl Y10 VL TNV KOVOVUE TTO PENAMOTIKY, KAOMG Kot KAUEPES Yo TNV TAOYNON
puécsa oto gvudpio.

Me ta epyalieion Materials kon Textures divovpe oto avtikeipeva S1AQOPES WO1OTNTEG OTOS
APDOLO, POTEWVOTNTO Kol ETIONG TOVG SIVOLE LOT] TOTOOETMOVTAG TAV® TOVS EIKOVEG, LLE TETOLO TPOTO,
MOTE VO PAIVETOL GOV T1 QUOLKT EMPAVELY TOVC.

210 OVTIKEIPEVO TTOV OvOmaploTovV To Waplo, Om®G Kol 6Ta GUKIN Y10 VO, T0 KAVOLUE Vo
©aivovTol O TPAYUATIKE, TOVG TPOGHEGALE KIVIOT UE TN XPTOT OKEAETOV.

AVOADTIKG 0 TPOTOC TOV PTLdYVOVTAL OACL TOL TAPUTAVE EWVAL GTO TOAPEPTNHAL 2.

To amotéieoua Oa evar owTd TNE EIKOVAG.
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Ewova 2 - Tehko amotéleopa amo To Blender

A@QoV TEAEIOGOLLE LE TO OTNHOUO TNG CKNVNG, TPEMEL VAL SIOUOPPDOGOVUE TO HOVIEAD LOG,
moTe Vo coumeplpépetan ooy moryvidl. Tov poro avtd tov avarapPaver o Game Logic Editor, o
omoioc avabétel oe kabe avtikeipevo evtodéc. Emiong pmopolue va ypnoLLOno|CovUE SCript NG
YA®ooag mpoypappotiopod Python ov  8élovpe kémoo oviikeipevo vo  axolovbnoelr mo
OUYKEKPIUEVEG evToies. o mapddetypo yioo Tqv Kivnom g KAUEPOC KOl TOV OyKIGTPLOD EXOvV
ypnoorombel dvo dwapopetikd script. Ta script Tomobetobviol v G€ £vo, OVTIKEIUEVO GE
cuvdovooud pe tov Game Logic Editor.

INo to pértpnuo tov moviov ypnowomomoope to Texts ta omoio tomoBetrcope o€ pia
dgvTEPT GKNVT TNV omoia puOpicape va Qaivetal TanTOYPOVA UE TNV PACIKT GKNVI LOG.

IIpocBécape Mo, o omoiog avamapdystol Katd Tn SIPKELD TOL ToLVIdoD, TOV 0Toio TOV
puBpuicape pali e 1o oKop TOL TOLYVIOD GE £Va KOO OVTIKEILEVO.

Mo to oviikeipevo to omoiot OvVOTOPIGTOOV TIC QUCOAIOEG, TOVG POAOUE MO QUGIKY
KATAOTOOT), DOTE VO, AVEPAIVOLY TPOG TO. TAVC®.

3.3  AwoKaoiec HovTeELOTON|61)G

3.3.1 Ewoayoym

H Boowkr povielomomon tov mayvidiod, éyve pe v epappoyn Blender. 1o povtélo tov
noyvidon, mpootédnkay textures, physics kot bones, evéd yio ) dpdon tov ypnoyomomOnKay
diapopa actions amo tnv game engine tov Blender.

Mepd ano ta Pacikd epyaieio oyediaong sivor ta Meshes, Empties, Lamps,Cameras, Bézier
Curves, Texts, Armatures.

3.3.1.1 3D Cursor

O 3D Cursor ypnotpomoteitot yio tnv tonobEtnon evog vEou avtikelpévov. O TPoEmAEYUEVOGS
TPOTOG Yoo €0KOAN TomoBEétnon tov elvar pe 1O 0PLoTEPO KAIK TOVL TOVTIKIOD, WAV®O OTI OKNVY.
Tapoia avtd epeic ypnoipomolodue 0o hotkeys yio peyolotepn akpifeia. To mpmto givar to shift C
Ue T0 07oio TomobeTovpE TOV KEPGOPO. 6TO KEVTPO TV aEOvmv g oknvig. To devtepo givar To shift
S, 10 omoio pag TpocPépel ddpopeg emrhoyés. Tnv B€om tov Ké€poopa pmopovpe vo ) pvOuicovpe
gmiong and v Kaptéda Properties mov Ppioketon kpopuévn ota 6e€1G TG GKNVAC.

3.3.1.2 Mesh

Elvow ta éropo mAéypata avtikeipévoy mov dwbéter to Blender, to omoia pmopovue va
YPTOULOTOUGOVUE OV TOVC 1| G GLVOLAGUOVC (OOTE Vo, ONuUovpynoovue omid 1 ovvleta

avtikeipeva. Me ovtdv Tov TPOTO QTIGEOUE TO OVTIKEINEVO Yioo TV GUMO TOL &vudpiov »°, v
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empaveto, Tov vepod. To otpdpo TG dupov to kévoue avaylveo pe tn fornbeia Tov Sculpt Mode mov
dwaBétet o Blender.

/|

€3 e Ve

'Ewkéva 3 — Mesh-Plane Y10, TO GTPAONA THG GRLILOV

3.3.1.3 Empty !

To "Empty" eivor évo kevo avtikeipevo mov dev mepiéyel xopio yeopetpio. Mmopel va

YAPNOLEDGEL MG YEPIOTNE GAADY OVTIKEIUEVDV.

Mepikd mapodelypota Tov TpOTMV XPHoNS TOVG:

o Mmopei va yivel YoVikO avTIKEILEVO Yia. EVa 1] TTEPLGGOTEPH UVTIKEILEVA, dIvovTag £TGL GTO XPNOTN
TN dLVOTOTNTO VO, EAEYYEL EVKOAOTEPO TOAAA OVTIKEIHEVE, YOPic va emmpedleTon 1 amoddon M
€KKIVNON TOL TOYVISLOD

e Mmnopei va ypnoyomonfet yloo TV QLGIKN KOTAGTACT TOV OVIIKEIWLEVAOV, | YO TIG OVAYKES TOV
OTAMG OV, JIVOVTHG GTO YPOTH TOAD TEPIGGOTEPO EAEYYO

e Mmnopei va ypnoomoindet yio vo avtioTadpicel ToAOTAOKESG TAPAUOPPDCELS

210 moryvior o Empty éxet 600 ypnoeic, cov parent yuo Tig KAUEPEG KOl GOV TO OVTIKEIUEVO GTO
omoio &yovv avatebel, ot yotl mov o avaTaPUyoVTOL GTO TOLY VIOl KOL TO GKOP.

3.3.1.4 Camera %

H camera givat éva avTikeipevo mov mapéyet eIKOveg mov £xovv omodobei ano to Blender. tnv
Game Engine Aettovpyel o¢ cvokevn o€ mpayuatikd ypdvo, £xovioag Hia GEPG omo mpdcheta
YOPOKTNPIOTIKA: Pmopel va xpnolponomfel wg oToTIK KAUEPA, ARG KOl MG [10. KIVOUWEVT] GUGKELT
e ToL TPOKOBOPIGUEVA TNG YOPAKTPIOTIKA.

Emiong omowodnmote avtikeipevo oto moryviot umopei vo ypnowwomoindel cav kduepa,
avAAOYOl LE TOV TTPOGOVATOAIGUO TOV.

KaBopiler mowd tunpata g oknvng Ba eivar opatd katd tov ypdvo omddoong.

3.3.1.5 Lamp !

INa 10 Qotiopd TG OKNVNG, YPNoomoovpe to Lamps. Amo 1o pevoy WHmopovpe vo
Sradé€ovpe avaloya pe To T pog e&uanpetei, £va oo ta S €ion mov £yetl to Blender.

I'o ™ oknv Tov oy VS, xpnoonomoape cov Bactkd eog to Hemi to omoio potilet
TavToL aveEapTnTo, amd To AVTIKEIUEVO TOV GTEKOVTAL EUTOSIO. GTO POC.

Me 1o Spot, mov eivar cov pukpog mpoPoréac, ewtilovpe to Fishtank Eeywpiotd omd v
VOO GKNVA.
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Me 7o Point potiCovpe pepovopéva aviikeipeva, Kot 1o Exovpe Baletl og didpopa Objects péca
oto Fishtank.

Inverse Square

Ewova 4 - Properties Editor yw. Ta lamps

3.3.1.6 Text

Ta Texts eivar avtikeipeva, 0nmg to Béziers curves ta omoia mepiéyovy keipevo. Emitpémovy
va dnpiovpynBel 6168146TaTO 1 TPIGOAGTATO KEIEVO, e SVVATOTNTO LUETAKIVIONG, TEPIGTPOPTS KL
OA®V TOV 1810THTOV 7oV £(0VV Ta volowa aviikeipeva. Xe Edit Mode pumopodue vo alhd&ovpe 0
nepileyOuevo tov keywévov. Me alt C oe Object Mode pumopovpe va petatpéyovpue évo Text o Mesh.

270 Oy Viol TO PN CUOTOIOVLE Y10, VO, PTIAEOVUE TO OVTIKEIEVE Y10 TO UETPNUO TOV TOVTOV,
OTOG PAiVETAL Kat 6TO TapdpTna .

3.3.1.7 Bézier Curve ¥

Mia xoumdoAn Bézier eivor pio mopopeTpiky] KOUmTOAN 7OV YPNGLUOTOLEITOL O YPAPIKE
VTOAOYIGT®V. X& OVUCUOTIKE YPAPIKA, YPNOLUOTOOUVTOL Yo TNV LOVIEAOTOINOT] OTAADV
KOApmuAGV. Zovn0mg avagépovtal ¢ “Atadpoués”, dnwg oe mpoypdupoto enelepyociog KOvVaC,
om0V €ival GLVOVOCUOL TV GVVIEdEUEVOV KauTuA®V Bézier. Xpnoionotodvtol exiong o animation
g epyaleio yia tov Edeyyo g kivnong. BY

2e 3D epappoyés, ypnoomolovvtal yio va kafopicovv Tpiodidotato PLoVoTAaTio.

Me 1t Ponfeta Tov kaumvidv Bézier pridape tov “maiytn’” tov mayvidion pog, £va. ayKioTpt
KOIL KGO0, AVTIKEILEVOL TOL OTTOT0L £XOVV TN LOPPT TOV GUKIOV® .
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Ewova 6 — dwapopooon 2 Ewova 7 - TeMKO amotélecpo

User Ortho

Ewéva 8 — ook oTioypéva pe Béziers curves

3.3.1.8 Object Modifier *°!

Ot Modifiers givat Aertovpyieg mov extelovvTaL avTtduaTa Kot exnpedlovy Vo avTIKEINEVO e
YOPIC OUMG VO KOTOOTPEPETOL 1) OPYIKT TOL doun Kol YewueTpio. Me Tn ¥pnor Tovg Umopovy va
EKTEAEGTOVV UNYOAVIKO TOALEG EVEPYELEG TTOL Ba NTOV KOLPOACTIKO VA YIVOUV LE TO YEPL Kot Y®pig va
oAraler n Paocwn yeopetpio Tov avtikeyévov. H ypnotikdmd tovg eivor oto 611 aAAGlovv tov
TPOTO UE TOV 0Toio éval ovTiKEipevo gppaviletol Kot omodideTal, aAAd HOVo KOVIKA. MTopodv va
npootefovv molhoi Modifiers oe éva avtikeipevo. Me to Apply tovg epapudlovue povipa og antd.
Yy mapakdto ewova Exovpe tovg Modifiers, Tovg omoiovg pmopodue vo pNOOTOGOVLE.
Yrapyovv 4 tomor Modifier.
e Modify: dev emnpedlovv dueco to oyfua Tov avtikeévov. e avtd avikel to UV Project to
omoio PBalel UV ovvietayuéveg oto avtikeipevo ko to UV Warp 1o onoio enefepydleton duvapuxd
Tig UV ovvietaypéveg
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o Generate: oAAGlovv 1 YEVIKN EUGAVIOT] TOL OVTIKEWEVOL, N TOV TPooBETovy autouaTa vEa
yeopetpia. Tov avikovv Modifiers, 6nwg 0 TOAAATAAGIAGUOS TOV AVTIKEWEVOD GUUUETPIKA, LE TO
Mirror, to Solidify, 6mov bivel fdboc oto aviikeipevo

e Deform: aAldlovv to oyfua evog avtikelpuévov dmmg to Armature, to Smooth, Wave

e Simulate: avtoi o1 Modifiers mpootifevtol avtdpata, 6tav givar gvepyomomuévo, éva Physics
simulation. Anuovpyobv ota avrtikeigeva pio euoikn Wwwwmta. Xto Simulate, avikovv ot
eopowvoeig povymv (Cloth), vypdv (Fluid), kamvod (Smoke), wkeavon (Ocean)

Ewoéva 9 - Modifiers

1o Fishtank ypnoporomoape tov Solidify Modifier yio va ddcovue méyoc oto ToyduaTa,
™G yvarog. Onwg gaivetor kot otnv gikova 10, 660 avédvovpe to Thickness, toco mo moyd yiveton
10 object. ITatdvrag Apply, epappolovpe pdvipo thv ariayf Tave oto object.

Ewova 10 — gpappoyn tov Solidify Modifier

3.3.1.9 Materials and Textures

Avo and 1o onuavtikotepa epyaieior tov Blender eivar to Materials kou Textures. Me
¥PNoN Tovg divovue oto avTiKeipeva Eex®PIoTEG 1OIOTNTEG KOl TO, KAVOVUE VO QOIVOVTOL PEUAIGTIKG.
Hapoxare Bo eggtdoovpe Tig dSuvatdmTeg TG epyaieinv avtmv yioo v unyovr] Game Engine tov
Blender.

Materials 61 371 [3€]

Me to epyaieio material, opilovpe Ti¢ 1610TNTEG TOVL BEAOVUE VOL £XEL TO AVTIKEIUEVO HOG KOTA
v amd6docn Tov. Ot W010TTeC aVTég Umopel vo glvar amd Ty Mo omAn OT®G TO YPMUC TOV
AVTIKEUEVOD, £0C Kot o oOvOeTeg dnw¢ 0 Ttpomog mov Bo mopovctdleTol KOTG TV EKKIVIioN TOV
TOLYVIOL00.

Ye k@Oe ovrikeipevo pmopovpe vo Pdiovpe 6co Material  0éhovpe. Mmopovpe va
YPTOULOTOLOVLE OTO10 Lag forevel kB Popd, 1) VO YPT|CLUOTOMCOVUE TAV® OO VO TOVTOYPOVA.
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INo kGOe avtikeipevo pumopovue va opicovpe mopomdve amo Eva materials. T kéOe material
7ov opilovpe GTO AVTIKEINEVO, UTOpPOVUE Vo PTIAEOVE textures, amo to omoio HOVO €vo UmOpEl va
ypnoomom0ei®,

=G

[ Er

Ewévo 11 — Koptéra Yo To Materials ucéva 12 — xoptéha Yo Ta Textu re
[39] [40]

Textures

Me 1o Textures mpocBétovpe vOEC oe éva avtikeipevo. Mmopovue va mpochiécovue €Tolpeg
glkoveg M ewkoveg mov Eyovv emefepyaotel oto Photoshop mave oe éva avtikeipevo, pe Paon ™
Ye®UETPiaL TOV Kot Vo PaiveTal o peoAtoTucd .

H mo omoteheopotiky Swdikacio tov texturing eivor m UV Mapping N oAMdg
yoptoypdonor. Me avti ™ péBodo, ol EMPAVEIEG TOV TPIGOLAGTATOV OVTIKEILEVOD «EESTADVOVTALY
Kol yivovtal S1GOlI0TUTES, €TCL MGTE VO UTOPOVUE VO TIG YEIPIOTOVUE oav €koOva. Metd v
eneEepyacio TG EIKOVOG, VIDVOLLE IE QUTHV E0VE TO OVTIKEILEVO, TO 0TTO10 EYEL TNV VET TOL BEAOLLE,
owotd tomofeTnuévn Téve Tov.

63

Yy ewovo 13 éyovpe o amoteAéopoTo Tov texturing 6to avTikeipevo g Gpov.
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v Use Alpha

Toile:

Ewéva 13 — to Plane g dppov pe Texture

2V emedvelo Tov vePoU, SoAéEape pia ewova 1 omoia amotedeiton omo TOALEG EkOVES, Yo
VO UTOPEGOVIE VO TTETOYOVIE TNV VO TOL VEPOD KaAvTepa. ExToC 0o tnv tomobétnon g eikovag
TV OTO OVTIKEIHEVO, KAVOUE Kol kamoleg pvOuicelg yuoo va dnuiovpynoovue v aichnon g
Kivong Tov vepon .

Ewoéva 14 — Texture ko AnimtiOuicag v To Plane Tov vepod

I to avtikeipevo Tov mAoiov, ywpicape ta Sidpopo TUAUATE TOV, o€ dapopetikd materials,
Kot og kGO éva Palape kot omo éva texture. Emiong ypnowonomoape ™ UV Mapping, kabdg ot
EMUPAVEIEG TOV TAOIOV N TOV TOADTAOKEG.

26



[Mtuyoxn Epyacio Tuqpoatog Mrnyoavikov [TAnpogopikng TEL Kprjtng

. o ] ‘
£t Mode e - o] . .

Ewéva 15 — Texturing ywo to Mesh tov mhoiov

Ewcova, 16 — 6ot ov Editors mov ypnopomon|Onkay ywo To mesh tov whoiov

Me avtov tov Tpomo PaAape VOEG G OAL TO OVTIKEIUEVAL.

Ewévo 17 — tehko6 amotéheopa o€ OAQ TO OVTIKEIPEVA TOV POVTELOV
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3.3.1.10 Rigging 2 LI

Eivor 1 dwdkacio pe v omoio. UmOpoOUE VO dMGOLHE KIVNTIKEG KAVOTNTEG KOl VO
TOPOLOPPDGOVLE TO, AVTIKEILEVA LLOLC.

®a ypnowonomcovpe T péBodo avtr ce aviikeipeva, to omoio TPEMEL Vo paiveTon OTL
Kévouv Kamole, Kivnom, 6w gival To Wwapto kot to, euKie. O TOTOC aVTIKEEVOL TOV YPNGIUOTOLEITOL
v TV vAomoinon tov Rigging eivar To Armature, to omoio Pociletal 6€ TPUYUOTIKOVG GKEAETOC
ov cvvavtdpe oty rpaypatikdmra. Ta Bacikd cvotatikd evog Armature eivar ta Bones, pe ta

omoio oYNUATICOVHE Evay GKEAETO Y100 £va avTIKEIpEVO %,

o @ op lode B NP L

Ewéva 18 — 1 epapyia Tov Bones mov falops sto Mesh yapr

21 cvvéyeto pe T ypnon animation Oa kévoupe ta bones mov pridape vo, kivobvtot 48],

Ewova 19 — o1 Editors ywa toAnimation wov 0o falovpe oto Bones

3.3.1.11 Physics

To Blender mepilapfavel Tpocopoimon PLOIK®Y 1810TAT®V, UE TN HOPPT| TG unxavr']]g Bullet
Physics n onoia pmopei va ypnoyromomOei yio moyvidio, alAd Kot yio o KvoOpEVO GYEDLO. [46
Ot emoyég ™ kaptédag Tmv Physics sivar dtapopetikéc yia kébe unyavn tov Blender.
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Ewova 20 — Physics

O1 tHmor mov mepiéyel | Blender Game Engine siva:

e No Collision: ta avtieipeva pe ontdv TOV TOTO HEVOLV OVETNPEACTO OO QLGIKO QTIL, EVO
HITOPOVV VoL TPOKAAEGOVY PUGIKES AVTIOPACELC.

o Static: dev emnpedletar amd uokd aitia, 0AAG pmopel vo emoTpEYeEL avTIdpAcElg GVYKPOLONG

o Dynamic: déyston kot emoTpEPEL avTIdpaoels. Otov mpokalel avidpact), UEVEL OVERTPENCTO

¢ Rigid Body: déyeton ko emoTpéPel avTidpaoels, aALGLovVTag TV TayLTNTO KOl TV TEPLOTPOP
TOV, AVAAOYOL TV OVTIOPOOT)

e Soft Body: avomopdotacn Tov HoAakod GOUOTOS, Y10, TOPASELY o HDOOCLLOL

o Occluder: amotpénetl Tov VITOAOYICUO TOV ATOSIOOUEVOV AVTIKEIUEV®V

e Sensor: to avtikeipevo Agitovpyel cov acONTNPOC TOL AVIYVEDEL TOPOLGIO GAAWDY OVTIKELUEVDV
YOPIG EMOTPEPOUEVEG CLYKPOVGELG

¢ Navigation Mesh: 1o avtikeipevo ¥pNGIUOTOIEITOL Y10 TNV EVPECT] LOVOTIOTIDV

e avtikeipevo 6mmg to Ship, Bridge, treasure_chest, stone, sword, to omoio, givatl akivinto
Kot dev ektehoOV Kamowo evépyela, toupralel to Static. O Adyog mov dev ypnoipomolodue 0 NO
Collision, givou emedn mopdAo mov to Objects avtd, sivar akivita, TpEREL va oIAANAETIOPOVV e GAAL
avTikeipeva o omoia Kwvovvtal. Omwg v mapdderypo to yapia To onoio 6mote oyyilovv avtd Ta
OVTIKEILEVA TTEPIGTPEPOVTOL Kot GLVEYILOLV TNV TopEia TOVG.

To yapla, 6nmg eivar ta objects Fish kou Acantharus, Balope to Sensor, kabmg Sensor
Baiape ko ota Armatures tovg. Ta kévape dnAadr| va Agttovpyodv cov atsOntipeg £€tc1 dote dtav
aviyvedovy avTikeipeva, ta onoia opicape oto Logic Editor, va ektelodv kdmoteg evépyetec.

To Hook (aykiotpr-maiymc) eivar kou avtd Static, alhd toekdpovpe v emhoyn Actor, £tot
hote Omote Epyetar o€ emaPn pe avtikeipeva ta onoia £xovv Evav Near Sensor oto Logic Editor, va
T0 PBpiokel kai vo gvepyomoteitan o avtiotoyog Actuator tov Near Sensor. Onwg Ko 6to TToyvior,
OTOV TO OYKIoTPL OTOV AKOLUTAEL £val Wapt, avtd eEapavileTol, OTmg £xovE TO £OVUE pLOuicEL 6ToV
Logic Editor.

To xapdxt o kdvovpe Dynamic étot dote va ivar 1 Kivor Tov 7o PEUAIGTIKY COLPOVA LE
TOLV PLGIKOVE VOUOVG Kol ToeKdpovLe emiong to Actor.

Yo seaweed kot To armatures tovg Bacovpe No Collision.

To Bubble object mov Byaiver and ta wapra ko and kamolo GAla avtikeipeva, to kévoue Soft
Body. Xtnv ewova 21, gaivovtar ot pubuiceig tov Physics, kabmg kot o Logic Editor ywa tqv kivnon
nmov Ba kdvel. Ttov Motion Actuator mapatnpovpe 6t 1 emhoyr Simple Motion éxst mopomdved
pvlpices.
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Ewova 21 — Bubble Physics kat Loic Editor

Ot kduepeg, ol Adumeg ka1 To Empty mov ypnowomomooape, Exovv amd mpoemidoyn to NO
Collision 1o omoio Ba apfcovpe £101, Kabmg Katd 10 TPEEIWO TOL TTaLYVIdoD, dev BEAOVUE VO, Exouv
Kapio evépyela Kot ETPPON).

3.3.1.12 Blender Game Engine
a. Ewcaywyn [47]

To Game Engine sivar pio Aettovpyia tov Blender mov ypnowomoieitol yio v KotooKeLn
S0 dpaoTIKOD TEPIEYOUEVOD GE TTPOYUATIKO Ypdvo. Elvar éva Aoyiopikd ave&aptitov TAaT@oppag, To
omoio &gl Ypaptel o€ YAmooa mpoypappatiopod C++ ko meprropfdvel vioompién yio Aertovpyieg
6mmg 1 Python scripting kot OpenAL nyo.

Ta yapoaktnpiotikd g eivar:
e Xpnowonotei £va cOGTNHA YPAPIK®V, To. Aeyopeva “logic bricks” ywa va eléyyet tmv kivnon kot
TNV OMEWKOVIOT] TOV OVIIKEWWEVOV YOPIc Tn ypNon TPOYPAUHATIOHOD, Jdivovias Opmg
duvatdtTo ETEKTAONG UE TN XpNoN Kamowwv Pifiodnkev g Python.
Aviyvedel GVYKPODOELC KL TOPEXEL TPOCOUOIMOT SUVOUIKNG LE TN xpnon Tov Physics.
Yrootpilel omovg oynudtov 6nwg kHPog, ceaipa, KOAVIPOS, KOVOS, KAWOLAN EVOoT).
Yrootpilel TANp®G T SuVOIKT OYNUATOV, 0TS TPIPT EAACTIK®V, SVCKOUY i, KAT.
TTapéyet Python scripting ywa mponyuévo €leyyo texvntg vonuosvvig.
Yrootpilel TANpwg 6Aovg Tovg TpdToVS PTIcHoL OpenGLTM.
Yroompiler ™ ypnon moAlamimv materials ot textures, 81Gpopovg TPOTOVG AvAUIENS VE®V,
QOTIGHO avd pixel, Suvaukd POTIGUS, TPOTOVG XOPTOYPAPNONGC, KIVODUEVA VALKA.
o Avamopoymyn moryvidldv Kol SledpacTikod TPIGOAGTUTOD TTEPLEYOUEVOD YMOPIC UETAYADTIOON N

npoeneéepyacia.

® Ymootpi&n Nyov.

OpenGLTM 18

H OpenGL (Open Graphics Library) givotl éva Aoyiopikd ave&oaptinton TAATPOPUOS TO 01010
avantoynke amo v Silicon Graphics kat dwyepileton amo tov duho Khronos. Eivor pio diemoen
Tpoypoupatiopov  epappoy®v (AP yio v amdédoon SiodldcTOTOV KOl TPIGOICTOTMOV
SlvucHOTIKGOVY  Ypapik®y.  Xpnotponolgitor  evpéwg oe  CAD, ewovikn —TpoypoTiKoOTnTa,
EMOTNUOVIKNG  OMEKOVIONG,  OMTIKOTOINGNG  TANPOQOPLOV,  TPOGOUOI®oNG  7ATAONG, Kol
Bvteomayvidia.

H OpenGL Shading Language (GLSL), givor pwd yAdooco mpoypoppaticpod vyniol
EMMESOV, M Omoia €IVl TPOCUPUOGLEVT] VO TPOYPOLLUOTILEL EPE oKIinoTG Y10 TPIOIACTAT YPUPIKA.
Anpopyndnke omd v OpenGL kon facileton otn obviaén g yAdooag Tpoypappaticpon C. (4]
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b. Game Logic Editor !

To mo onuavtikd koppdtt g punxavig Game Engine tov Blender, sivar o Game Logic Editor.
Iapéyel v KOpra péBodo yro T dnpovpyia kKot v enegepyacio TG AOYIKNG TOL ALY VSO0 Yo O
TOL OVTIKEILEVE TTOL GLVOETOVV TO TOLYVIOL.

Xopiletar og d00 pépn, to nedio Properties kot 1o medio pe ta Logic Bricks.

>to Properties npocBétovpe 610 mayvidl 1010TNTEG OTMG TOPASELY U0 TO LETPNUO TOV TOVIWV KOl
m Spketa {ofg tov maiyrn.

310 de0TEPO MEDIO £YOVLE TIG TPELG KaTnyopieg Twv Logic Bricks- Sensors, Controllers, Actuators.

Amo 1o medio Sensors diadéyovpe pe mowd Tpémo Bo divovpe evtoAn yio vo yivetar pio
evépyela. Avotyovtag ) Alota, PAémovpe o1t £xel Stdpopovg tvmovg (Ewdva 89). (1
Actuator: aviyvebdel mote kdmotlog actuator Bo Adfetl Evav ToAUO EvepyOTOINGNG
Always: divel cuveymg Eva onpo e£660v
Collision: aviyvedel cvuykpovoelg ueta&d avrikelpuévoy | materials
Delay: kabvoteprion €£660v amd Evo cUYKEKPIUEVO aplOUd AOYIKMOV TOAUDV.
Joystick: aviyvevet gicodo amo v Kivinon yeipiotnpiov
Keyboard: aviyvevel 6060 and T0 TANKTPOLOYLO
Message: evtomilel unvopata 1 1010TNTEG
Mouse: evtomilel KIViGELG TOVTIKION MG £1G0J0
Near: aviyvevel avtikeipeva Tov Bpickovtal 6€ KATOW amdGTIoN
Property: evtomilel aAAayéc 6TIG 1O10TNTEG TOV AVTIKEWUEVOL OG £i0000
Radar: evtomilel avrtikeipeva mov KIvouvtol 68 GLYKEKPIUEVT amdGTOOT OO KATOWN YOVid TV
aovav
Random: mapdyet tuyaiovg ToApong
e Ray: aviyvedetl yrompata evromilovtag o axtiva 6ty KatevBuven tov dEova
e Touch: evromilel mdTe dVO avTiKeipeva EpYovVTaL GE EXAPT LETAED TOVG

To nedio Controllers givat ot EAeYKTEG TOV GLAAEYOLV TaL ELGEPYOUEVO DESOUEVE TV SENSOrS
Kol TPocdlopifovv TV Katdotaor. APov EKTEAEGOVV KATOESG EIOIKES AEITOVPYiES, OTEAVOLY TOALOVG
6T0Vg Actuators [E TOVG 0TOi0VG GUVIEOVTAL. =21
AND
OR
XOR
NAND
NOR
XNOR
Expression
Python

O mapaxaro nivakoag delyvel Ta anoTEAEGHATO TOV AOYIKOV TPaEewv amd Tovg £E1 TPMOTOLG
Controllers. Xt otAn pe tovg Oetikobg maANODS, EXOVUE TOVG TAAUOVG TOV CTEAVOVTOL OTO TOVG
Sensors pe Tovg omoiovg eivorl cuvdedeuévol. Xtig othieg pe tovg Controllers éyovpe v aviomdkpion
T0vG oTovg ToApuovc. To True onpaiver 6t o1 Actuator mov eivor cuvdedepévol otovg Controllers Ba
evepyomomBovv, eKTeEAdVTAG TNV VIO Tov dmONKe, evd to False onuaiver 6t ot Actuators dev Oa
gvepyomomBolv Kt dpa koppio eviodn dev Oa extedeoTsl.

OgTikoi TaAipoi Controllers
AND | OR | XOR | NAND | NOR | XNOR
Kavévag False | False | False | True True True
évag False | True | True True False | False
molhoi False True | False | True False | True
0oL True True | False | False False | True
Controllers
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O Controller Expression, givat pio ypamt) ékppacn, 1 omoio av givor aAndng diver Ogtikn
£€0d60. H éxppaon avt) umopei vo givar otabepég, petafintés, pabnuotikég mpatels, Aoykég mpdéelg
N VIOOETIKEG EKPPACELS. 53]

Me 1ov Python Controller yivetonw mpocbnkn Python Scripts oto avtikeipevo. Ta Scripts
ypapovtol otov Text Editor.

Y10 medio Actuators, yivetal 1 €KTEAEO TOV EVEPYEIMV OM®G 1 Kivnom, n onuovpyia
OVTIKEWUEVAOV, 1 OVOTOPUY®YN ﬁggov, kAm. Evepyomolobvtar 6tov Adfovv amnd tovg Controllers
TovAdyloTOV Evay BeTiKO TaANO. [54
o Action: yepileton Tic evépyeteg omhopob (armature).

e Camera: ypnowonoleitor amd Kauepeg M OGAAO avTikeipevo, £Tol ®OTE v okoAovBovv e
OHOAOTNTO GAAC OVTIKEILEVO

e Constraint: ypnopomoteitor yio va meplopilel Tov ydpo VoG AVTIKEWEVOV, 1| TNV TEPIGTPOPY| TOV,
EMIONG YPNOEVEL Y10 TOV EAEYYXO TMOV PLGIKAOV KOTAGTAGEMY TOV AVTIKEWEVOL GTO TTatyVidtl

o Edit Object: ene&epydleton ko aAAGLEL TO AVTIKEILEVO, TPOGOETEL 1] KOTOGTPEPEL OVTIKEILEVQ,

o Filter 2D: mpocBétet piktpa yia 101Kd £QE, OTOE BAum®UA

o Game: amo &dmd yeplopacte 10 TOoVidl, emovekkivnom, €£0d0¢, EOpTOUO. ToLVISoD Kol
amofnkevon

e Message: otédvel UnvOLOTO TO OTTOT0 EVEPYOTTOLOVV GAAL QVTIKEIEVEL

e Motion: divel ota avtikeipeva Kivion avaloyo pe tig emhoyég Physics mov éyovpe opicet

e Parent: kaBopilel TNV TATPOTNTA TOV AVTIKEIUEVDV

o Property: yepiletor Ti¢ 1O10TNTEC TOV AVTIKEIUEVDV

o Random: dnpovpyel toyaisg TYéG 01 0TTOlEC YPNOUOTOIOVVTOL GITO TIG WOLOTNTES

o Scene: dwyepileton TIg OKNVES 6TO aPYEio Hag

e Sound: avamapdysl Nyovg 6To maLyVidt

e State: oALGCel TNV KOTAGTOCT TOV OVTIKELUEVOD

e Steering: mapéyet eThoyEg €DPEGNC LOVOTOTION Y10l TO CVTIKEILEVO

e Visibility: aAAGlel Tov tpoémo mov QaiveTal TO OVTIKEIHEVO

. Text Editor

O Text Editor givoxr n meproyn oto Blender émov ypdpovue to Python Scripts. Anuovpyodue
éva kawvovpio text and to button New. Onog gaiverol otny eikdve, 1o dvoua tov apysiov givon Text,
70 omoio pmopovue va to aArd&ovpe. Ta 3 kovpumd dimia omd to dvopa givar EMAOYEG KEWWEVOD, HE
T1G omoieg apBueitar KAbe GEPA TOL KEWEVOL, CUUTVKVAVEL TIG YPAUUES £TOL OOTE VA TIG PAEmovue
OAeg ave€aptnra pe to péyebog tov Editor ko ypopatiCel i AéEg Tov kMK OV £X0VV KAmTola,
onpocia.

Ewova 22 — Text Editor
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To kovuni Run Script Tpéyet To TUAHA TOL KOJIKO TTOL £yovpe Ypawel. To gucovidio Tov text
dimla 610 Ovopo mepiéyet pio Aota pe ola ta text files mov £yovpe ypdwel oto mapmv .blend apyeio.
Amo 10 pevov, to View €xel emAoyEg epepaviong tov Tapabddpov, amd o Text pmopovue va tpé&ovpe
T0 script, vo. T0 amoBnkedoovpe. Ano 1o Edit kGvovpe avtiypa@)/emkOAANGN TOV KEWEVOL, GO TO
Format éyovpe emthoyég tov Keévov, Onms TPosOnkn oYoAM®mV Kot YPAWIHO KEWWEVOD TO UEGO. XTO
Templates £yl d16popeg ETOYES TAATPOPUES O1 0TToiEg TTEPLEYOLVY ETola script oe Python, ta omoia
puropovpe va avoiovpe kol va Ta emeEepyactovpe avdioya pe To L BEAovpe va KAVOLLLE.

Hapaoderyua

Yy mopokaTo ewdva, PAénovpe ta Logic Bricks yio v Camera0l. Ot 600 npdtec eviolég
glvar ya v Kivnon Umpoctd Kot Tiom ovtictoyo pe ) xpnon tov tinktpov W kot S. H emopevn
glvar yuoo v evarliayn petalld Tov Kapepdv Tov Tarvidlol, pe To TANKIPO 2 yuo va petapepBolpe
otV kauepo. 2. Ot tedevtaieg eviorég meplapPavovv dHo Sensors tovg Always kot Mouse, ot omoiot
ovvdéovton pe évav Python Actuator, Aéyovtag €1l , OTL pE TN YPNOT TOL TOVTIKIOD Y10 GLVEYEG
ddoua Ba exteAeiton To python script mov éyovpe evooet.

Empty01 Add Sensor - Empty01 Add Controller ' Empty01

Set Camera

€

Ewova 23 — Logic Editor ywa tig pvOpiceig Tng Camera0l

210 mapdpmpe " eoivoviar 6Xot ot Logic Editors mov ypnoipomototviot 6to matyvidt kabohg Kat Ta
script yio. tnv Kivnon TOL TOVTIKLOD KOL TOV OVTIKELHEVOV.
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4. AITIOTEAEXMATA

4.1  Am6ooon maLyviowov

To moayvidr pmopovpe va 10 tpé€ovpe péow tov Embedded Player xai tov Standalone
Player™,

4.1.1 Embedded Player

Agrtovpyei péoa and to Blender, kdrtt to omoio pog fondast katd t didpkeia TG dnpovpyiog
TOV TOLLYVIO0V, Vo TopakoiovBovpe TV TpOOdO Tov.

Yrapyovv tpeig TpoOTOL Yo Vo TpEEOVUE TO TTayvidl péca amd Ty epappoyn. O TpmTtog givar
and 1o pevod Game—>Start Game Engine. O dgdtepog givan and to Properties Editor otv xaptéia
Render, natdvtog to kovpni Start oo Embedded Player. O 1pitog givar matdvtoag 1o kovuni P otov
3D Editor. Kot pe tovg 3 tpomovg 1 avéivon tov moryvidiod Ba givan o tiuég oto Embedded Player.

To amotéleoua Ba gival Koo emiong Kot Yio TOvg 3 TPOTOVE, Ol TOPUKAT® EIKOVEC dElyVOLV
évo oTrypotuno yuo kabe kapepa pécm tov Embedded Player.

[ Blender™ [C:\Users\greeklover\besktop

PN ER) | secrcome 1D

Score:

Singletexture
/| Lights

/' Shaders

/' Shadows.

/' Color Management.

' Use Frame Rate /' Display Lists
/' Use Material Caching

on

Auto Select

DEF O I ERGs)

Ewéva 24 - Oyn Camera0l amo Tov Embedded Player
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« X:1920 » [ Y1080 »

K

off
Bit Depth: 32

/' Color Management

/' Use Frame Rate ' Display Lists

/' Use Material Caching

S a0

Ewova 25 - Oyn Camera02 amo Tov Embedded Player

4.1.2 Standalone Player ©°!

To moryvidtl tpéyel oov eKTeEAESIUO apyEio, xopic va eivar amapaitnto va avoiovue to Blender

N va 10 égovue oTov VIOAOYIGTH pog. Amo v emidoyn Standalone Player oto Properties Editor,

matovtag to Start avolyovpe éva véo mapdBupo oto omoio Eekvd va tpéyel 10 Touyvidl. XT0

Resolution and kdtm emiéyovpe v avaivon tov moapadvpov, natoviog to Fullscreen kdvovpe 1o

oy viol vo epeaviletor g OAn v 006vn, eved to Desktop to mepropilel oto péyebog g emipdvelog

€PYOOIOG TOV VTOAOYIOTY.
Mo va xévoope 1o moyvidt va pmopel va tpé€el ywpig va eivon amopaitmta ovorytd To

Blender, axolovBovue v e€nc dradikacio:

e Amo 10 pevov File avoiyovpe to User Preferences B Sty koptéha Addons Siohéyovpe v
koatnyopio. Game Engine kot toekdpovpe 1o Save As Game Engine Runtime. Aivovpe étot v
duvatdmra oto Blender va propéoet va e&dyet to maryvidl cav éva eKTEAESO 0p)ETD.

o Tlotaue File>Extenal Data—>Pack into .blend to omoio maketdper dha to e€mtepikd apysio mov
£YOVE YPNOUOTOMNGEL OTME TIG EIKOVES Yia To. textures oto apyeio .blend.

o Pvbuifovpe amd v kaptéra Standalone Player v avéAvomn, kot otyovpevduacte OtL £x0vue
eMAEEEL TNV GOOTI KAWEPX, OTT0 TNV 07T0i0, BAETOVLE.

e [lape amo 1o File>Export->Save As Game Engine Runtime. TIpocéyovpe va givar emieypéva
Kato aprotepd to Copy Python Copy DLLS kot dnpovpyovpe évav véo @dkero and to Create
New Directory. péca oto @dkelo awtd motdpe o kovuri Save As Game Engine Runtime.

Ewova 26 - Evepyomoinon tov Save As Game Engine Runtime
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[Ipéner va mpooéovue av oto @dKeAo mov e&dyoaue 1o moyviol pe v KatdAnén .exe,
vrapyovv kat ta .dlls Tov kabdg ko évag pdrerog pe Tig Piiodnkeg g Python.

Emiong, mpénel o @drerog tov ekteAéoiov va eivar poll pe Toug QUKEAOVG TOV EXOVLE TO
texture ko 6Tt GALO YPNGLOTOMGOALE Y10 TV DAOTOINGT TOL IO ViS00, £TGL OCTE VO UTOPOVLE V.
TpEYOLLE LE emTLYio TO TOLYVIOL.
2TIC TOPOKATO €KOVEG PAEmOVUE TO TOPABVPO TOV EKTEAEGIUOL OPYEIOV TOV TOYVIOOV HE TNV
katdAnén .exe. ano tigc Camera0l kou Camera02.

i < fishtank o @%w

Ewova 27 - Standalone Player Camera0l

i < fishtank o @%w

Ewéva 28 - Standalone Player Camera02
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4.2 Xopumepdopoto,

2V apyn TG VAOTOGNG TG TTLYOKNG epyaciag, anodeiytnke 6Tt to SketchUp dev ftav to
KATOAANAO TPOYPOULO YO TOVG OKOTOUG NG epyaciag. Eivor pia epoppoyn kabapd yio tov
GYEOOGUO TPIGIACTATOV OPYLTEKTOVIK®V oyedimv. 'Etol 0 oyediooudg cuveyiomnke 6to oxedlactiKd
npdypappa Blender.

O U6VOC TPOTOC YO VO KETKOIVOVIGOLV» T0, dV0 TPOYPAUUOTH HETOED TOVG, TV O TOTOG
apyeiov Collada. 'Etot kévoue export to povtédo omo to SketchUp oe popoen Collada kot to kévapue
import oto Blender pe v ida popen. Kato ) dadikacio sicayoyng/eéaymyng peta&d tov 600
TPOYPOUUATOV, £YIVOV SOKLUES Y10 VO SITIGTOCOVE LE TOLOV TPOTO O LETAPEPULLE TO LOVTELO GTO
Blender @ote va gival 660 10 duvatdv To 0YPNGTO GTO KOVOUPLO TPOYPOUULLO, POV Ol TAEVPEG TMV
QVTIKEWEVOV TOV HOVTEAOV, dlopovvtav Ue TNV glcoymyn oto Blender, kdvovtag €16t mo dHvokoin
v ene&epyacio Tovg.

Avoiyovtag to Blender €idape éva moddmAoko interface, eivon oyedloaocuévo e S10(pOPETIKO
TPOTO amo GALO TOPOLOLN TPOYPAULATO, TPOCTAOMVTAG Vo TPOGPEPEL Eva TTEPPAAAOV MO OIAIKO
TPOG TO XPNOTI.

Ta TAeoVEKTAATE TOV SOTICTOGAUE EfvaL:

o Eivot eledBepo hoyiopiko, £xet ukpod péyedog kot éwvon dabéoipo o Windows, Linux, Mac OS

o  O1 ePIOGOTEPEG EVEPYEIEG TOV YIVOVTOL UE T YPNOT CLUVTOUEDGEWDY TANKTPOAOYIO

o Alvelr ) dvvatdmra 6To YpNoTn va tpocsapudcet to interface g epappoyng 6mmg tov foredet kat
TOV OPECEL

e Awbéter o Outliner to omoio deiyvel OAEG TIC GKNVEG KO TAL AVTIKEIPEVA TOV PpickovTal o€ aVTég
epapynuéva

e EvkoAn ypron ko otnv tomobétnon Armature miveo oe €va aVTIKEIEVO, LE TNV ETTAEOV XPHON
Tov gpyoreiov yio Animation mov dSwbétel, doTE 0 OKEAETOC TOL EMGUVAMTOVUE OF &vol
AVTIKEIUEVO VO, £YEL Kat TN duvatdTNTO, Kiviomg

o Tlegpiéyet avarvtikég pubuiceig yua ) dnpovpyioc Animation

e [0t dnpovpyia Toyvididv dwbéter ta Logic Bricks évav ypaeikd tpdmo yia va divovpe viorég
ot avTIKeipeva ko emiong dwabétel evompatopévo eneEepyaoct keywévov ya Python scripting

e Eivar ovpPotod pe moAlovg tomovg apyeiwv onwe Collada, 3D Studio, Wavefront, Autodesk FBX

O1 topeig otovg omoiovg eldape 0TI voTEPEL glva:

e Eivar dvokoro kot ypovoPdpo otnv eKpadnon Tov GOOTE Vo, UTOPEGEL O YPNOTNG VO TO
YPNOLOTOUCEL TOPAYOYIKA

e XToV YPOoQIKO OYeONOUO OVTIKEWEVOV: TOPOAO TOL €YEL £TOUN TPIOOAOTATA GYNUOT, €ivat
S0OKOAO VO GYESIAOES €val TOAVTAOKO HOVTEAD OTMG Y10 TOPAdEYU €vo. avOp®dTVO Gmduo M
KeEPAAL

o Tlgpimhoxn yprion tov Materials ko Textures ko 1 xpnon twv UV Maps

¢ Rigid n Soft boddies mov tvydv éyovue Parer Yo physics oe avrtikeipeva, Kabvotepovv mOAD T
@OPTOOT KoL TNV adO0CT| TOV TOLYVISIO0

o AA\dlovv Paocikéc pvBuiceig onmg tov Materials, avaueoa otic Tpelg unyovég mov dtabétetl 1o
Blender

Y& YeEVIKEG YPOUUES 1 YpTIoN T®V 600 TPOYPOUUATOV HTOV IKOVOTOMTIKY. YTNPYE OVCKOAQ
Yo TNV €KUEONon Kol TV KOTovonoen Tovg, oAAd avtd 10 eunddlo EEMEPAOTIKE GYETIKG YPIYOPQ.
BpéOniav o1 duvatdtnreg kot o1 advvapieg Tovg, Kot 1 xp1ion yio Ty oroia ival katdAinia.
To 1eMKd OTOTELECUA NTAV ETMIOTG UKOVOTOMTIKO, OV KOl TOAAEG POPEG NTOV OVOKOAN 1 Sladikacio
0AOKANPOOTG TOV.
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IHAPAPTHMA

A. SketchUp
A.l Oyn kapepog kot paocikd epyaieio,

Amo 10 pevoy avoiyovpe éva véo apyeio, £Tol MOTE va LG TO avoiEEL e TO TPOTLTO TTOV
emAéEape. H mpoemdeypévn Ooyn eivan m Top View, ywo vo v oAldEovpe mape 610 HEVOD
Camera->Standard Views kot emihéyovpue v oy mov OELovpe.

[ Untitled - SketchUp £ |
File Edit View Draw Tools Window Help
Top Previous
X 4 I
lext
B G Standard Views » Top |
B/ Parallel Projection Betton
Yo v Perspactive From:
Two-Point Perspect ook
v® =
Match New Photo. .. Right )
X & Edit Matched Photo ’ T |
~ i
o g Orbit o
5 F v Pan H
D Zoom z
RS Field of View
& Zoom Window Ctrl+ShiftsW
oom Extents +Shift+
Zoom Exte Ctri+Shift+E
X & Zoom to Photo |
ﬁ 2 Position Camera
et Walk
Io\ L Look Around
1R & Image Tgloo I
&
oo
|
1
| [eYoYelle) Measurements

Ewéve 29 — interface tov SIZetchUp KO 01 EMAOYES OYNG TOV

Kabe popd mov 10 kdvovpe avtd, mapotnpovue 0Tt GAAALoVY Kot ot AEoVES oV Qaivovtal
oV 000v1. O koxkivoc a&ovag cvpuPoirilel Tov dEova TV X, 0 TPAcIvog Tov AEova TV Y Kol 0 PUTAE
TOV Z. 1o aplotepd ¢ 000vng £xovpe to mapdbupo pe Ta EPYOAEID TOL YPTGILOTOIOVVTIOL Y10, TO
OYESOCUO TV AVTIKEWEVOV, TO. 0TOio LTtopovpe vo, Bpodue amd to pevod View=>Toolbars=>Large
Tool Set.

A.l1l.1l Xyeowaopog Tov facikov cyediov

To avtikeipeva mov etiaope pe To SketchUp eivon to tpaméll, To evodpeio ko n fdon tov, 1
AGuma Ko T S®MUATIO OTTOV LTLAPYOVY OAOL AVTA.

M6 avaivtikd, yio o tpoméll, oyedidoape évo opboydvio Topolinidypaupo pe to Rectangle
10 omoio kavaype tpiodidortato pe to Push/Pull. T cvvéyeia petprioape pe to Dimension kot to Tape
Measure Tool, ta onpeia oto onoio OEAoVHE VO dSNUOVPYNCOLLE TO KOWYTpHATA Y1 TH dNpovpyic TV
ooy tov Tpamellod. Exerta gtidyvouue éva dgvtepo opBoydvio mopoAANAGYPOAUIO, TAV® GTO
onueio Tov Béhovpe vo Eyovpe kevd, kot pe to Push/Pull dmpovpyodpue pio tpoma 1 omoia va
dwamepvael To apykd kovti. Apov etid&ovpe pe ovTdV T0 TPOTO TO GYNKO TOL TpamelloD pe to Line
Tool oyedidlovue pio ypouun og kabe mievpd tov tpomellod. TEAOG emAéyovpe TV TAVD ETPAVELD,
ko pe To Scale Tool v dapopemdvovpue. Ot Tave evépyeteg gaivovtal otig eikoves 30 £wg 34.

IMo ) yvdia eriagape éva Kouti, Onwoe Kavape mpy yio 1o Tpaméll, Kot EMAEYOVTOG TV TOVEO
emeaveld tov, motnoape delete. T ™ Paon euaape évo amhd Kovti, evd Yy 10 dOUATIO
npocbicape 5 diodidotota oploydVIa TUPUAANAGYPAUUA, £VA Y10, TOVE 3 TOlYoVE, Eva Yl TO ToPdvi

KoL VO Y10l TO TATOLA.
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A.2 Materials — Styles

To SketchUp mepiéyet v mpocbnkn vedv Kot LG ETITPETEL VO, 0PIGOVUE 1APOPA GTUA OTAL
OVTIKEILEVAL.

A.2.1 Materials

Emi\éyovtag to Paint Bucket epovieton éva mopabupo pe (’)voua Materials.

Mmopobpe vor emAEEOVLE ETOWEG VPES Y10 TO. OVTIKEILEVO HOC, 1) HTTOPOVLE VO TPOCHEGOVE
dwéc pag. Totovtag to kovuri Create Material poc spgaviletar to devtepo mapabvpo g Ewkovag
35.

Me 10 kovumi Browse for material image file, avoiyovpe éva mopdBvpo omd t0 omoio
UTOPOVLLE VO ETAEEOVE TNV EIKOVA TOV OEAOVE VO, TOTODETGOVILE GTO OVTIKEIEVO.

Create Material...

. N

Color

Materials

. | Water_Deep

Select l Edit ]

¢| Q m‘lnl\‘lodel j E}

'

. @*ﬂ

Picker: Cclor Wheel

-\:h

Texture

Select [V Use texture image

& B s <] & [ [foor convons B
el - 2 I Colorize
. . . . - % [200m }{?’ Reset Calor
Opacity
|1 fo—

oK. | Cancel |

Ewova 35 — materials Tov SketchUp

@ Untitled2.skp - SketchUp - ! .

File Edit View Camera Draw Tools Window Help

B BPH XN WX AdOE B~
PIBERIEELICE NN &<

@ @ © | @ Select objects. Shift o extend select. brag mouse to select multi Measurements

Ewova 36 — arotéheopa pe v TposOkn materials ota objects

A.2.2 Styles

To uevod View mepiéyel emiong KAmoleg eMAOYEC OL OTOIEG EivOil YPNCIUES Y10 TO GYESAGUO
TOV OVTIKELLEVOL UOG. ZTIG EIKOVEG TTOL 0KOAOLOOVV POivOVTOL TO OTOTEAEGLOTO TOVG,.

a. H View->Shadows: gpeavilel T okid TV aVIIKEWEVOVY
b. HView>Fog kdvet: ta avtikeipeva doumrd
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c. H View->Edge Style>Edges: av sivar togkopiopévo @aivoviolr ot ypopués yop® amnd to
OVTIKEILEVOL.

d. H View-> Edge Style->Back Edges: supavilet kot tig nicm ypappéc StokeKoppuEvVeg.

e. H View-> Face Style=>Wireframe: epoovilel povo 1ig axpéc tov avtikeipevov, 6mmg to X-ray
oA o€ aoTPOUOVPO

f. HView-> Face Style>Hidden Line: eppavilel povo tic akpég Tov ovTKeEvo.

g. H View=> Face Style=>Shaded: spoavilet ta ook ypdpata mov BAAope 6T0 AVIIKEINEVO, YOPIG
TG VOEC.

h. H View-> Face Style> Monochrome: epeavilet to avtikeipevo asmpopovpo.
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Ewova 38 - doxipég amo to pevov View

B. Import — Export
B.1 ECaymyn anoé To SketchUp

INo va e€dyovpe eva apyeio and 1o oto Sketch Up matdpe and to pevod File>Export. Mag
eupaviCovron 3 vd-emA0YES, TIC onoieg Sahéyove, avaroya pe to apyeio e&aywyng mov BElovpe va
dnuovpynoovue:

e 3D Model
INo e&aymyn evig tprodidotaTov TepIBAAAOVTOG

44



[Mtuyoxn Epyacio Tuqpoatog Mrnyoavikov [TAnpogopikng TEL Kprjtng

e 2D Graphic

INa v e€aymyn plog d1001d0TaTNG EWKOVOS

e Animation

Mo mv e€aywyn Kivovuévev oyedinv

B.1.1  Eayoyn tprootdctatov povrtEAov

File>Export->3D Model

Onwg eaivetor oty Ewova 39, umopodpe vo eEdyovpe €va Tpiodidototo HovTéAO o€ 600
Tomovg apyeiov. O évag givan pe ) popen Collada File (.dae) kot o dAdog pe v Google Earth File
(.kmz). To apyeio .kmz mov Ba dnuovpyncovue, uropovue va to avoifovue pe v epappoyn Google

Earth n ool Oa T0 TOomOBETHGEL G€ vl onpEio oV emBLUOVLE.

Rl ot toge DAE Export Options -
Savein: [ exporting from sketchup - «®EeiEr
L= Name ‘ Date modified Type Size i
F = 5 .
A Urniled 2/11/20135:45..._File folcer
- Untitled3 3/11/2013 2:34... File folder [~ ExportEdges
|<] fishtankl.dae 2/11/2013 5:28.. DAE File 672 KB )
Desktod | fishtank2.dae 2/11/2013 5:36... DAE File 753 kB IV Triangulate All Faces
— . |
= || Fishtank3.dae 2/11/2013 5:42.. DAE File 671KB [ Export Only Selection Set
or | fi : i ] |
Libraries: l fishtankscae 2/11/2013 5:48... DAE File 820 KB [ Export Hidden Geometry
A ] fishtanké.dae 2/11/2013 5:50.. DAE File 838 kB ) ) I
c:mp:m ]| fishtank7.dae 2/11/2013 5:52... DAE File 844 KB IV Preserve Component Hierarchies
iy || fishtank8.dae 3/11/2013 2:19.. DAE File 89 KB Materials
l‘,- || fishtank?.dae 2/11/2013 6:03.. DAE File 822 kB % Export Texture M
Netwok | Fisptank10.dae 3/11/2013 2:27.. DAE File 835 KB Kpart lexiire faps
] fishtank1l.dae 2/11/2013 6:05.. DAE File 822 kB [ Use "Color By Layer” Materials
| fishtank12.dae 2/11/2013 6:06.. DAE File 822 kB !
= Fichtank12 dns 2M1/2M2 A4 hAF Fils aNT ¥R S cred“.s
File game [Untited cae -l Export [ Preserve Credits
Export type: [COLLADA Fie " dae) =] Cancel \
‘ i || CK | Cancel | |
Google Eatth File ("kmz) Options.. [
—

Ewéva 39 —tdmor e€aymyng 3D povrérov Ewcéova 40 — emoyés stayoyic .dae
To apyeio .dae, pe to omoio Oa acyoinbovpue, sival o udvog tomog e€aymwyng mov drobétet To
SketchUp, o omoiog pmopei va ypnotpomomBei kot amd GALEG TPLOOIACTUTEG EQPOPUOYES OTWS TO

Blender. Ztnv emhoyn Options gpeaviCetot to mapabvpo tng Ewdvag 40.

2T1C EMAOYEG:

Geometry:

e Export two-sided faces: duthaoialet Tov aplOpd Tmv ToAVYOV®V ToV apyeiov mov eEdyetal, KOOMS
e€ayel pion OYM ylo TNV UIPOGTIVI] Kol Lot Y10 TV TG® TAEVPA TOV OVIIKEWUEVOV, EXPPASHVOVTOG
£161 TNV AmOS0GT TOL

o Export edges: n emloyn avti ypNCIUOTOEITAL YioL TNV SATHPNON TOV OPUTOV GKUDY EVOG
LOVTELOL

e Triangulate all faces: pe avtf v enthoyn OAeg Ol EMPAVEIEG TOV AVTIKEWWEVOD, dLOPOVVTOL GE
Tpiyova, eneldn KATOIES TPIoIACTOTES EPUPHLOYES VTTOGTNPILOVY HOVO TPIYDVIGUEVES OWELS

e Export only selection set: e&ayel emdeyuévn yeouetpio oty meptoyn oxediaong

o Export hidden geometry: Ed@yet v KpoupEVT YEGUETPIO TTOL VILAPYEL LEGA GE EVOL LOVTELO

e Preserve component hierarchies: dwatnpei v iepapyio tov ototyeiov

Materials:

e Export texture maps: emdoyn yio va eEGYOVLE TIG VPES GTO OPYELD HaG

e Use “color by layer” materials:
povtédov tov SketchUp

B.2 Ewsaymyn oto Blender

‘Exovpe mAéov dnpovpynost kot e&dyel o apyeio, and to SketchUp kot givar cepd va
eneepyaotel omd to Blender.

e€ayel ta vAkd g yempetpiog, Pacel Twv ovabécewv Tov
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IN'o va ewodyovpe éva apyeio oto Blender emiléyovpe amd to pevov File=> Import émov pag
epupavitel tic €€ng emhoyéc:

COLLADA (.dae)

Motion Capture (.bvh)
Scalable Vector Graphics (.svQ)
Standford (.ply)

Stl (.stl)

3D Studio (.3ds)

Wavefront (.obj)

X3D Extensible (.x3d)/(.wrl)

3+ IEECTT P3| " ¢ E ERF| | lencerGame

084 YSPIR

Ctrl Alt U
Ctrl U

Ctrl Alt O
Shift F1

(1) Lamp

® Object Mode 1@ B LA EPE clobal

Ewova 41 — tomor sisaywmyng 3D povrélov oto Blender

Emléyovpe to Collada agod avtdv tov 00 apyeiov ypnoluonotcape yio. thv eoaywmyn omod
to SketchUp.

AoV 1o emhé&ovpe, avoiyel éva mapabupo oto Blender dmov pag eppovifel Toug pokélovg
apyeiov Tov vroloyiot) poc. EmAéyovpe 1o pdkelo otov omoio £yovue amobnkevoel 1o Eayouevo
apyeio, to Toekdpovpe ko watdpe Import-> Collada. Apéong pag to avoiyet, kot TAéov umopodue va
10 ene€epyacTopE Kat va 1o amobnkevocovue g .blend
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S (=B B EAEIAIE

Ewova 42 — gmloyn Tov apyeiov .dae wov 0&hovpe va sicdyovps

B.3 Amoteléopata

Kdavovue Export and to SketchUp to povtého mov @ridéape, yopic veéc Kot ypoUaTa., UE TIG
npoemheypéves pubuices Tov Options.

4

> RLPE XV VOX 4dOE 2~ |2
SIVHIBEZICEIDING

it Yiew Conars Orew Tosls Window Help

-

QOO @ omginsrectimmpon Weasrenerss

Ewova 43 — povtédo oto SketchUp o s&oyoyn 1

A@ov kdavovpe Import to povtélo oto Blender (Ewova 44), moapatnpodue oto mopdbupo
Outliner mov pog deiyvel ta avtikeipeva, 0Tt To. 6Vo TpdTo pe ta ovopata SketchUp, SketchUp.001
KA ovapEPOVTOL [E TN GEPA 0T YudAa, ot Bdomn ™C, 010 TPuméll, 6TO TATMO KOl GTOVG TO1XO0LG
TOV dUATIOV.
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O0000a0d

Ewcova 44 —povtélo mov kavape stoaywyn oto Blender 1

Eniong mapatnpodpe 6ti, av farovpe veég oto povrédo (Ewkdva 45) ko Eavoakdavoope v
dwdikacio etloaymyng/eEaywyng ta avtikeipeva oto Blender éyovv avénbdei (Eikova 46).

& Untitled2.skp - SketchUp
File Edit View Camera Draw Tools Window Help

e BLPH XUV VO AOB R~
DYIBIEIEE S ICE NN &C

@ ® © | @ setect objects. Shift to extend select. Drag mouse to select multi Measurements|

Ewova 45 - povrého oto SketchUp ye e€ayoyn 2

Kdabe @opd mov e€dyovpe amd to SketchUp éva apyeio oto omoio €xovue Pdrer voéc,
QUTOHOTO SNULOVPYEITOL EVOC PAKEAOG LLE TO OVOLO TOL OpyEiov, 0 0mMoi0g TEPLEYEL LECH TIG EIKOVEC
TOV VOOV TOV YPNCIUOTOICOUE GE LOPPT| .jPy.

Eniong xévape Kamoleg SOKIUESG e VOES Kal [E OLAPOPEG EMAOYES OYNG KOl OTIA TOV LOVTEAOD
kot amd v emroyn Options wov Ppioketar oto EXport, kol kabe apygio mov dnpovpyodoaue to
gloayape oto Blender. TTopaxdto avapipovtal To avaAvTiKd o1 pLOUIGEIS KOl T0 OTOTEAEGLOTO.
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Inu.: Ze kabe ewkova otV omoio @aivovtol ot dOKIUES, N CEPE TV OTLYHOTVTTOV gival | €ENg and aplotepd
npog ta de&id: and to SketchUp pe tig pubpiceig mov tov kavape, oto Blender ta amoteléopota o Solid Mode,

oto Blender og Texture Mode, Render Result xou Start tng Game Engine.

a. To povtélo mov e€dyaue amd to SketchUp, eiye 1 pvbuiceig Face Style->Shaded with
Textures ko1 Edge Style=>No edges. v enthoyn Options dev £yovpe emAéEet Timota.

© XL BRI E DD

OT#PE*FumIOk 40
O
i

import/export 1

Ewova 47 —

b. Pvbuiceig oto SketchUp, Face Style->Shaded with Textures ko Edge Style->No edges.
Yty emhoyn Options toekdpovpe to Export Texture Map.

i . J Blender.
View Comers Draw _Tools Window Help

il {
T

O TRPG FamvOx 408 @
g VUG SEE AICE DN &
e
’]'
=\
A

Ewoéva 48 — import/export 2

c. Pvbpioeic oto SketchUp, Face Style>Shaded with Textures kot Edge Style>No edges.
Yty emhoyn Options toexdpovpe Use Color by Material.

il Edt View Comers Draw Tools Window Help
L]

8

| %2

®C

v®

HL

o3

S ‘
2

& = =]
S
QX l“:

LEd y
O®O @1 weomrarens

Ewcova 49 — import/export 3
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d. PvBuiceg oto SketchUp, Face Style=>Shaded with Textures kouw Edge Style=>No edges.
Yty emhoyn Options toekdpovpe To Export Texture Map kot to Preserve Credits.

Uriid oy et -0
View Comers Oraw Tools Window Help

Ba-
N @Ol

RPE XN VOX 40
BHRISEZ2ICE DD

Ewova 50 — import/expt 4

o
g
o
s
i
s
i
§

e. PvBuiceic oto SketchUp, Face Style->Shaded with Textures ka1 Edge Style->Edges. Ztnv
emhoyn Options toekdpovpe to Export two sided Faces, Export Edges, Export Texture
Map «ot to Preserve Credits.

7umv|.4»snvdu— L .

File_Edit View Comers Drow Tools Window Help | B

e
b A

S B2 ICEIINGO

P
R

XU VOX 40

or #®
© %
L
&)
i
H

f.  PvOuiceig oto SketchUp, Face Style=>Shaded with Textures kot Edge Style=>Edges. Ztnv
emoyn Options togkdpovpe to Export Texture Map, to Preserve Credits, Triangulate all
Faces.

)
File_§dit_View Comara Orew Teols Window Melp

RPEF AW IOK 4OB & -
B EEEICE DN &

€ otiec Hoo-

Ewéva 52 - import/export 6

g. PvBuioeic oto SketchUp, Face Style=>Shaded with Textures kot Edge Style=>Edges. Ztnv
gmloyn Options toekdpovue 10 Export Texture Map, Export Hidden Geometry kat to
Preserve Credits.

;
i
i
i
i
i
i

W EEE A E DN &

RPEXF VB VOX AdOE @
% M &

]
©
©
&

| € oo 1] © =

Ewk6va 53 - import/exrt 7

50



[Mtuyoxn Epyacio Tuqpoatog Mrnyoavikov [TAnpogopikng TEL Kprjtng

h. PvBuiceig oto SketchUp, Face Style=>Shaded with Textures kot Edge Style=>Edges. Tty
gmloyn Options toekdpovue to Export two sided Faces, Export Edges, Export Hidden
Geometry, Export Texture Map, kot to Preserve Credits.

mort/expo t 8

OI#PEHFAWCOX 4dOB @ - 7|
O BHISEE AILE DN &

] Ewoéva 54 - i

i.  Apyd emdéyovpue pe to Select Tool mowd avtikeipeva Tov poviédov Béhovpe va Edyoue.
PvOuioeig oto SketchUp, Face Style=>Shaded with Textures kot Edge Style=>No edges.
v emoyn Options toekdpovpe o Export two sided Faces, Export Edges, Export

Hidden Geometry, Export Texture Map, to Preserve Credits kot to Export Only
Selection Set.

- sherchig e 12 e 3
Yiew _Comers_Orow_Tools_Window tielp

~TF
VUG ERE I DN SO

loT# 8 *Sevar <0l

©
&)
9
¥

Ewova 55 - import/export 9

j.  Pvbuiceig oto SketchUp View->Shadows, Face Style->Shaded with Textures xoi Edge
Style>Edges. v emioyr Options toekdpovpe to Export two sided Faces, Export
Edges, Export Hidden Geometry, Export Texture Map, kot to Preserve Credits.

7 vies - seroiy SN, e [
Eile_Edit View Comara Orew Tools Window Help |

BY
| ¥ ‘

PEXUVeVOQX 40
M B2 AEE R

.4
b)

O
©
s]
S
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C. Blender

C.l Baowkd gpyaleia
To interface tov Blender epeoaviCeton oto mapdbupo g Ewdvag 57.

p

C GEETTIND ECTTTED G 55 R DR

Ewéva 57 — Blender interface

Ynid oty 006vn, £xovpe tov Info Editor o omoiog mepiéyet to pevod yio v eneepyacio
TOV apYelmv, Yoo TNV E1I00YMYN OVIIKEWEVOV OTN OKNVY, PLOUIcELS Yoo TNV avomapdoTooT Tng
OKNVAS, Yt TO TapaBupo TG epapproyns kot Borfeta.

To Blender emtpénet otov ypnotn 0V, va. dapopemcsl Omwg Béhel owtdc to interface, ta
ypodpata, to hotkeys, tig kivioelg Tov Tovtikiov. Amo to puevov File> User Preferences, avoiyet 1o
noapadupo g Ewodvag 58, 6mov pmopodpe va pubpicovpe ta tapomdve.

Ewova 58 — User Preferences

Mropodue va gEdyovue kat va gwodyovpe apyeion amd to Blender. tnv Ewdva 59 &yovue
oG THIOVG sloaywyng (import) kot oty Ewdva 60 tovg thnovg e€aywyng (export). Ot tonot apysiov
nov Oa ypnowomomoovue, eivar to. Collada (.dae), 3D Studio (.3ds), Wavefront (.obj) vy 10
importing kot yio To exporting, evd emmAéov yia to exporting fa ypnoiporomcovue o Save As Game
Engine Runtime.
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Collada (Default) (.dae) Collada (Default) (.dae)

Motion Capture (.bwvh)

Save As Game Engine Runtime
Scalable Vector Graphics (.sva)
Stanford (.ply)

St (.stl)

X3D Extensible 30 { x3d/wrl)
Ewova 59 — import types

X3D Extensible 3D ({.x3d)
Ewova 60 — export types

e To Collada o6mwg simope ko1 o€ TOPUTAV® €VOTNTO EIVOL HIOL GUVEPYUTIKY OpAGTNPLOTNTA
oYe0lGHOY Yo TN Béomion [ HOPPNS AVIOAAOYNG apyeEl®mV Y10 OOPUCTIKES TPLCOIACTOTES
epapuoyéc. Ta Collada éyypaga mov meprypdpovy ymoerokd ototyeio, eivor apyeic XML kot
ouvnBmg TovtiCovton pe v enéktacn apyeiov .dae

e To .obj eivon évag yeopetpikdg opiopds yio popen apyeiov. Avamntoydnke yio Tpdtn Qopd amd
Wavefront Technologies yio 1o Advanced Visualizer éva makéto Aoyiopukod yia 3d ypagikd ko
animation. Avto¢ o TOmo¢ apyeiov givar avorytdg kat £xel vioBeOel amd AAAovg TpounBevTEG
TPLEOLACTATOV EQUPUOYRV YPapik®dVy. Eival pio moykoouiong omodekt popen O6edouévev Tov
avamaplotd Tplodidotatn yewperpio, T 0éom kdbe wopverg, T UV Béon «dbe vong
GUVTETAYLLEVOV KOPLPAV, KOl TIG EMPAVELEG TOL KAVOLV KAOe ToAvY®mVO va opileTor g o Aota
KopveaV. Ot GUVTETOYUEVEC TOV .0bj dev €xOuV HOVADES, €TCL TO. v AOY® apyeia pmopoldv va,
TEPIELOVY TANPOPOPies KAMpaKag Tov va givar avayvepioyies omd tov avopamro. &

e To .3ds givon pia amd Tig popeég apyeimv mov ypnoomrolovvtal ard o Autodesk 3D Studio Max,
éva Aoyiopiko yua 3D oyedlacpo, animation Kot amdd0om.

e To Save As Game Engine Runtime Agttovpyei amoxdielotiké ot Game Engine tov Blender xat
g€ayetl To mayvidl Tov Exel dnuovpyn el pe TIg KIVAGELS, TIG LOEC Kol OAQ 0G0, TOV £YOVUE PAAEL

To pevov Add, drobétet To. avtikeipeva, Kapepeg, AAUTES, oTAMoUODS Kot 0Tt GALo ypeldleTat
v va. cuvbécovpe pio oxknvi. Amo to Add=>Mesh propovpe vo Bpodue avtikeipeva toHmov ceaipag,
KOBov, K®Vov, KLAIvdpov, K.a.. Amd to Add->Camera npocbétovpe pio kapepa. Add->Lamp
Aaumeg avaAoya pe 1o gidog mov Béhovpe. Add->Armature Balovpe onAMoPO 6€ KATOL0 OVTIKEIUEVO.
Eniong vmapyet ko o Add=>Empty->Plain Axis to omoio mpocbétel amhd tovg 3 d&oveg og éva
OVTIKELLEVO.

To uevov Help umopovue va Bpovue didpopa ypriotpa tutorial yia v expddnon tov Blender.
Eniong am6 1o Help—>Splash Screen avoiyetl 1o mapabupo 10 omoio gppoviletol kot 4tov ovoiyovue
™MV €Qapuoy. Tta aplotepd Tov mapabvpov Exovpe Eava Toug cLVIEGHOLS Yo To Site Tov Blender
o tutorial. Zto de&1d £xovpe Ta TO TPOGPATA CPYELD TTOV EYOVUE OVOIEEL.

A Blender 2.67b

Ewéva 61 — splash screen

2mv Ewova 62 pmopovpe va emié&ovpe pe mowd popen Bélovpe va emefepyactodpe T
oKNvn pog, oniadn ov Béhovpe va etid&ovpe Animation Oa SodéEovpe v avticTtoyn €mAovN.
‘Emerta, PAémovpe pio AMota pe TIG OKNVEC TIC OmOieg £€YOVUE KoL WTOPOVUE OO €KEL va TIg
enefepyacToULE.
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-
/=) Blender

=

O oerout |3 i8R scene |

Ewoéva 62 - Blender Views

Téhog ot Aloto 6710 TAAL, EXOVLLE TIC TPEIG UNYOVES OTIG OTTOIEG UTOPOVLE VL SOVAEYOLLLE GTO
Blender, dniadn tig Blender Render, Blender Game kat Cycles Render.

e Blender Render: givor n telikn} avomopdotao 0mov dnpovpysitat  elkovae 1 0Toic avVamaploTd
v 1plodidotatn oknvy pog. Tlepiéyet ypopupu olpmons, avitypaen e aKTivog eOToc, EUIEGO
QOOTICUO Kot omoepatn TepBAAAOVTOC TOV popel vo e€Ayel o€ PeydAn Totkido LopemV

e Blender Cycles: avtiypdoer v aktiva eotdg Kot Kavel drodpaoctikd rendering, £xet d1kd tov
GOOTNHO oKiooT|C Kot Snovpylag vedy kot emtdyvvon GPU Y

e Blender Game: mpoceéper ™ Onuovpyio. SlOOPACTIKOV TPIGOICTATOV EQPAPHOYDV N
Tpocopoldcemv. Kavel cuveyr| anddoorn oKknvav 6€ TpayHoTikd ypovo Kot TPOSPEPEL EMOTG GTOV
YPNOTN SuvaTOTNTEG IAMAEIBpOIoTC KOTd T Sidpketa tng Studikasiog omddoonc. P2 163

Avti va, Stahéyovpe kdBe popd molovg Editors Oéhovpe va ypnoipomomoovpue, to Blender £xet
étona kamowa interfaces. Avtd Ppiockoviar oty mpodtn Aicta tov Info Editor. Avtd mov Oa
ypnowonomcovpe gueic eivan to. Animation, Default, Game Logic, Scripting, UV Editing. Kabe éva
omd outd éxel mpoemdeyuévong kamolovg Editors, tovg omoiovg pmopovpe mhvta va aArd&ovue
avaAOYOl UE TIG OVAYKES LOG.

C.2 Blender Game Engine

Epeig 6o acyoinBovue pe ™ unyavy Game Engine xat 6o cuveyicovpe v meptypaen tov
Blender cg avtv a@ov 6An 1 eneéepyocio Tov poviéAov Ba yivel exel.

AMGLovpe Aowmdv amo T Alota mov avoeépaue Toponave, to Blender Render oe Blender
Game.

Kot ot dvo avtoi tpdémor paivovtar otnv Ekova 63.
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Aultitexty
¥ Outline Selected
¥ Lights v Ramps
v shaders ¥ Nodes
4 Relationship Lines
¥ Shadows ¥ ExtraTex

~ GridFloor X ¥ > T
ol

v UseFram ¥ Display Li

¥ Use Mate

Ewéva 63 - GLSL Shading

>to interface g epapuoyng dev oAlalel timota and mpv. [apatnpovue Lowmdv o6t ywpiletol
og 5 uépn. e 5 dwagpopeticovg editors tovg Info, 3D View, Outliner, Properties, Timeline.

Tovg Editors avtovg, pmopovpe vo tovg aAAGEovpe, aviloya pe 1o Tt pog e&uanpetel va
Kévouvpe kéOe popd. Onwc paivetarl oty Ewkova 64 natdvrag Tave oe évo, eikovidlo evog Editor pog
gpeaviCer kol Tovg vroAomovg mov dabitel to Blender. Avtoi mov Oa ypnouonotcovue epeig
kupiog eivar ov Info, 3D View, Outliner, Properties, UV/Image, Logic, Text, Timeline, Graph,
DopeSheet, Python Console.

User Persp

Eu«’wa 64 — Blender Editors

e Info Editor ektog tov mopandve mov avaeépbnkov, dabitel éva mAicl0 ©6T0 0mOi0
SLUTANPGOVETOL 0WTOpOTO 6€ YAdooo Python onowadnrote evépyeia kdvovpue oto Blender

e 3D View Editor o omoiog kotodapupaver to peyoddtepo pépog g 000vne, mepiEyel Ty oknvn
oTNV omoio dSNUIOVPYOVUE TO LOVTEALD UG YTAPYOLV TPOEMAEYHEVE O KAUEPO, L0l AGUTO KoL
évog koPoc. Akpifdg amd Katm omd ™V oknvy vdpyel éva pevov. Xto View dgiyvel kdmolo
gpyodeia yio TV eneEepyacio TOV OVIIKEILEVOV, OTMOG ALTO GTo aploTePd TG 000vng, dyelg and
T1g omoieg pumopovpe va dodue to avtikeipevo. To Select pmopodue va emiéEovpe Ta ovTIKEipEva,
TIG KAUEPEC VO KAVOVUE OVTIOTPOPN TV emAeyuévov. Emiong nepiéyel kamowo ypnotua epyoleio
gmloync. 1o Object &yovpe emhoyéc yia 10 avtikeipevo, OTmg Stoypa®mn, UeToKivior, puOuicelg
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Kivnong, petapopd oe arlro layer. Aimho oto mhaicio £xel Tig kotaotdoeslg (Modes) ue Tic omoieg
UTOPOUE VO EMEEEPYOOTOVUE TO OVTIKEIUEVO. AKPIPMG SImAC €)EL TIC KATOOTUCEL OKINONG TIG
omoieg pmopovue v evalddoocovus, avaloya tn dovigia mov Bélovue vo kavovue (Viewport
Shading), to onpeio oto omoio o givar o dEovag mepioTpoeng Tov avtikeévon (Pivot Point), ta
gpyolela Yoo TOV TPIGOACTOTO YEWPIGHO TOL avTiKeWEVoL pe PBdon tovg dEoveg, KabBMG kol Tov
npocovatoMopd Tov aovev. To kovtdkia dimha, ivon ta. layer ta omoia mepiéyel pio oknvn Kot
BonBdve otov édeyyo Kol TV opyAvOGCT PG GKNVIG

e Outliner deiyvel éva 6&vTpo pe TV tEpapyio TV ovTIKEWEV®Y ToV Bpiokoviot o€ kabe oknvi. Ot
Kot vo Tpocbécovpe o éva avtikeipevo, kamota ven 1 animation, Ba eavei kdto amd avtd. Eniong
ot 0e€1d TV avtikelwévoy Egovue tpio eikovid. Me 1o patt puvBpilovpe av To avtikeipevo Oa
QOIVETOL GTNV GKNVI], UE TOV OEIKTN OV TO OVTIKEIUEVO UTOPOVUE VO TO EMAEYOVUE KOL HE TNV
Kauepa, ov Oo paiveton katd To Rendering 1 to Start

o Properties divet tig 1816tnteg yioo o Rendering, yio v kd6e oknvi, yio Tov KOGHO dnAadN yio. TO
YEVIKO TEPIPAALOV TNG OKNVAG MOG, KOL Y10 TO AVTIKEIUEVA. ATO TIC 1O10TNTEC, UTOPOVUE VO TOVG
aAra&ovpe Béom, péyebog, vo T TPOTOTOMNGOVUE, VA TOVG PAAOVUE YPOUATH Kol VOEG Kol VO
TPOGIOPIGOVLE TNV PLGIKT TOVG GUUTEPLPOPA

e UV/Image Editor ypnowonotitor yioo v amddoon Tov HOVTELOL oov gkova. Emiong
¥PNOWoTOtETOL YiaL TN dnpovpyia vE®V, pe ™ péhodo Tov UV Mapping

e Logic Editor eivar 10 Pocikdtepo gpyareio yio ) dnpovpyio evog d108pacTtikol TPIGOIAGTATOV
HOVTEAOL, ] EVOG Ty VIS0V, e avTdv Bo Tpocdiopicovpe Tt evépyeleg Oa yivovtal péca ot oK
Hag

e Text Editor sivar évo evoopoatmopévo onueiopotdpio tov Blender oto omoio pmopovpe va
ypawyovue python scripts. T va Aettovpynoet, yperdletor o Logic Editor

e Timeline, ypnowevel ywo ™ onuiovpyia keyframe kol mopokorovBnon evoc Animation péowm
AVTOV

o DopeSheet Editor deiyver mo Aemtouepmg ta keyframes kot pog emttpémel vo tovg Kévovue
aAAyEG, OTTMG avVTLYpOPT], LETaKivoT, dlaypoen

e Graph Editor d&iyvel éva didypappo toydnrag-amdctaong o onoio kabopilel Tnv tayvTnTo Kot
mv emdyvvon tov avrtikeipevov. Ta onueio mov eoaivovtar ce avtd eivon ta keyframes won
UTOPOVLLE VO GAAGEOVE TNV TAXDTNTA EVOC OVTIKEEVOD, TEWPALOVTOC QVTA

e Python Console Editor givatl pio koveoro oty omoia ypapovpe eviodés oe yAmdooa Python ot
omoieg Umopel va avapEPOVTOL 6NV ENEEEPYACIN TOV LOVTELOV Y10, TOPASELY LG KOL VO EKTEAODVTOL
AUECMG

C.3 ANpovpyio OVTIKEINEVEOV

Amo to SketchUp dnpovpynoape ta Bactkd aviikeipeva tov matyvidtod pog kot pali pe to
textures KATOL®V 00 aVT®V, Ta 16Ayoue 6to Blender.

Y10 Blender npocOicaue kamowo e£tpd avTikeipeva o, omoio Katefdoaue amd TNy GeAlda
¢ Turbosquid, ToAAG and To omoia giyov étopo texture maps. IlpooBécape 300 emmAéov ya
dnpovpyia g dppov Kot tov vepol. Tomobethoaple TIg KAUEPES e TIG omoieg B TPoNyOoLUACTE GTO
oLVl Ko TIC AGQUTES Y10 TOV QOTIGUO TN oknvic. Emiong dnuovpynoope kamowo avTikeipeva, e
YPNON TO®V KApTuAdV Bezier.

a. Meshes

IMa ™ dnuovpyia 10V €0MTEPIKOD TOTMUATOS TOL €VVOPEioV, B ypnoLLOTOTGOVUE EVal
Plane, dniadn| éva eninedo.

Apykd Ba emdé€ovpe o avtiKeipevo 0 omoio givol To gvudpeio pag, kol matdvrog Shift
S>Cursor to Selected 6o BdAovpe Tov képoopo oty idlo Béon mov givar kot to gvudpeio. Xt
ovvéyela Oo maue amd to pevov Add->Mesh->Plane kow 6a wpootebel 610 onueio mov Ppioketatl o
képoopag €va Plane. AAalovpe to Mode ce Wireframe kdtw otov 3D View Editor, kot kévovpe 10
péyeboc tov Plane ico pe to péyeboc tov matov TOL EVLdpeion. TN cuvvéxeln Eyovtag to Plane
gmleyuévo petopepopoote oe Edit Mode ya va 1o eneepyaotodue dote va 1o Kavovue va notdlet
ue éva, otpodpo auuov. Xe Edit Mode notaue amd v kaptéda Properties tnv emloyn Subdivide kot
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and katm oto Number of Cuts Balovpe 30. ‘Etot to Plane 6o ywpiotei og 30 pukpdtepa koppdrio, to
omoia pmopovpe va eneéepyactodpe Eeywplotd to Kabe Eva.

e

Ewova 65 — dnpovpyia plane

Ewéva 66 — enctepyoosia plane og Edit
Mode

Metd aAldlovpe omd Edit Mode oe Sculpt Mode kot ard Wireframe oe Solid. Xto Sculpt
Mode umopovpe va copmepipepbodpe oto KaOe avtikeipevo cav éva yAvmtd. Me 1o movtikt Aoudv
dnuovpyodue eéoykopata tdve oto Plane émwg omv Ewova 67. Téhog emotpépoviog oe Object
Mode motdpe to xovumi Smooth amd v koptéda opiotepd g oknving Tool Shelf, dote va
OUOAOTOMCOVUE TNV “Aupo” Hag.

(3 o D08 BB G k&)

Ewoéva 67 - eneEepyacia plane g Sculpt Mode

Me tov {610 tpdmo dnpovpyovpe Evo Plane yio to vepo, to pépvouvpe oto 1610 péyebog pe oawtd
™G Gupov, aAAd dev to enelepyalduaote og Edit Mode 1 oe Sculpt Mode. H dwapudppmon avtod tov
Plane, 6o avoAvbei mapoxdto.

b. Bezier Curves

Me 1 BonBeia tov kaumviov Bézier pridéape tov “maiytn’ Tov moyvidlod pog, va aykiotpt
KOl KOO0 OVTIKEIIEVE TOL 0TI £YOVV T LOPPT] TOV QLUKIDV.

I dnpovpyia tov aykiotprov, avoifape and to pevod Add tov Info Editor, tnv emhoynm
Curve->Bezier.
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User Ortho

Half
~Fill Defor

Minimum 5 v R

Ewéva 68 — mpocOikn evég Bézier Curve

Me tig emAoyég rotate, move, scale pépvouyie T KapmoAn ot 0€on mov BEAovpE.
Metagepouevol oe Edit Mode (Ewova 69) pmopodue va emelepyaotodpue T0 GO TOV
Béhovpe va €xel 1 KOUTOAN LLOG.

Ewova 69 — eneéepyaoia Tov Curve og Edit Mode

210 onueio 1 g ewovag, PAETOVLE KATOEG YPOUUES Gav BEAN TAV®D GTNV KOUTOAT, TO. OTToio
kaBopilovv v apyn kot to téAog ¢ Tao onueio 2, gival n apyn (kGte) kot 0 Téhog (Tav®) TG
KapmoAng. Kavovrag khk méveo toug Kot totoviog G Umopodue vo LEYOADGOVUE TNV KOUTOAN HOC.
Eniong notdvrog Ctrl kot KAk enekteivovpe Ty KaumoAn omd pio kopven, og 6moto onpeio Béhovue
gueic. Amo ta onueia 3, pe 0e&i KAk UTOpPoVUE VO OPIGOVIE TNV TEPIGTPOPN TNG KOUTOANG. ZT0 4 1
gmloyn Handles amevepyomotel Tig KOKKIVEG YPOUUES LE TIG OTOIEC TTEPIOTPEPOVUE TNV KOUTOAT], EVGD
n Normals anevepyonotei ta BEAN mov deiyvouv T opd g. Xt0 5 to kovuni Toggle Cyclic evdvel og
KOKAO TIg GKpeg TG KapumvAng, kot to Switch Direction oAlaler ™ @opd twv Pekdv. Lo onpeio 6,
VIapyel o AMota pue emhoyéc yepioparog e koumoing. To 7 kot to 8 eivar to, avtikeipeva to, omoia
emmpedlovv v kaumoAn. To Bevel Object sivar ekeivo ocdugovo pe to omoio 1 koumdAn Oa
amoKTHoEL éva oynua, To Taper Object givar exeivo to omoio Oa SlapopPMOGEL TO Gy TNG.

AxolovBdvTog ta mapomiveo eTIaEaue 1o Bactkd oxfua Yo to aykiotpt. O KOKAOG mov
eoivetal TAve, givar 0 0dNyog Yo va yepicovpe v koumbAn. IMotovrag to Bevel Object ko
emAéyovtog To dvopa tov kKukAov. Xe Object Mode av pukpdvovpe tov kdkro, avtdpata Aemtaivel Kot
0 “coMvas” Yopw and v kapumroAn (Ewovae 70-72).
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Ewéva 70 — Bacwko oyfjue Curve  Ewéva 71 — yémopa Curve Ewova 72 — swopopoowon Curve

Emiong oty Eikova 71 PAémovpe 0TL UTOPOOLE QKOO VO TEPICTPEYOVLE TIV KOUTOAT).

IIpocBétovpe pia devtepr KapumOAn oe onueio 6nwg oty Ewdva 73. Evod épovpe emheypévn
™ Baocwn pog Kopmdin, daiéyovue oto medio Taper Object ) 6gbtepn KaumvAN OV TPOGHEGALLE.
Emléyovtog tng xan og Edit Mode umopovue mepdlovtog v KapmvAdTnTd e, Vo S10UOPPDCOVUE
TO GYNLO TOV AYKIGTPLOV.

AxoiovBovpe v 1010 dradkacio, yio pio akoOpo KopmdAn, 1 oroio Oa eivol 10 okovi 610
omoio gival depévo 10 aykiotpt ko évag kOkAog Bezier tov omoio pmopodue vo eme€epyactovus
akppog 6mme kot Tig Koumorec. To telkd amotérecpa eivar otnv Ewova 75.

Avtd opwc mov Eyovpe @TIAEEL givan avtikeipeva Tomov Bezier Curve, yio vo umop£covpe vo
TOL YEPLOTOVUE oav To VIOrowa, TpémeL va ta petatpéyovpe oe Mesh Objects. Emidéyovpe to Curve
10 omoio Béhovue va petatpéyovpe ko maue amd to pevod Object->Convert To>Mesh From
Curve/Metal/Surf, Text 1 aAliog ypnoponoidvtag to Alt C.

Télog kévovue parenting 6Aa ta mesh objects kot emhéyovtag ta, ta kavovpe Export coav
.0bj, y1a va. pmopécovpie vo, Ta E1I6AYOVUE GTO TOLYVIOL.

[# BezierCircle.001 X

Ewova 73 - dropopewon 1 Ewéva 74 — Swopoépomon 2 Eucéva 75 - tehié amotérzopa

Axpipdg ™ 010 dladiKocio. SNUIOVPYNOAIE TO KOUAKL KOL TO QUKLO, OTMG QOivovTial 6TV
gwova 76.
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Ewova 76 —avtikeipeva oyedroopnéivo pe Bezier Curves

Amotéleopa

TomoBetdvtog OAa ta aviikeipeva nali, Exovpe T0 amotéAespo ¢ ewovag 77. Tnv yvdia,
TOoVG TOlYoVG Ko 1o TOaPdvi Ta €yovpe KPOWEL Yoo Qaivetol To €0MTEPKO Tovg. Emiong éyovue
Tpochécel kot TIG Kapepeg oe ddpopa. onueio, MoTE va umopovue va, Tponyndodue Katd ™ Sidpkeia
TOV TTOLYVIOI0V.

Ewova 77 — anotélespa 6Lov Tov objects Tov waryvidrod

A@ov tomofetnoape OA0 TO OVTIKEIEVE TTOL GVVOETOVY TO T VidL pog otn Béom Tovg, Gelpd
£YEL VO TOL KAVOLPE OGO MO PeaMoTIKG umopovue, mpocbitovtag tovg Materials, Textures ko
Balovtog og doa mpémel onAiopd (Armature).

C4d Materials and Textures

Onwg &xel avapepbel o Topamdved EvOTNTO, KATOLO OO TO OPYIKE AVTIKEILEVO TOV HOVTEAOV
nov glodyope oto Blender, giyav non veéc amd to SketchUp. Ta vadlowra, Ba to LopPOTOMGOLLE e
115 puBuiceis tov Blender, pio diadikacio n onoia eivar evieldg dtapopetikr and avth tov SketchUp.
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C4.1 Materials

Ewova 78 - Material

Apywd pe v epdacn Cube>Material kotoAofaivovpe 6t 0 avtikeipevo 10 omoio Oa
emeEepyactovpe €xel To Ovopa Cube.

270 TAIG10 0TO KATM VIAPYEL Ui, AloTa pe To material to omoia govpe PaAel 6TO avTikeipevo
pac. IpocBétovpe ko apapodpe amo ta +/ -.

Opilovpe éva 6voua yio to kéOe material. Ao kdTe emAéyovpe g BEAovue va paivetol
kato, To rendering 1| TNV EKKVNGT TOV TOLYVISI00 TO OvVTIKEIEVO. Surface ot 1) GOUTAYNG LOPPT TOV
OVTIKEWWEVOD, Wire Vol U LopeN TAEYHOTOC, volume to avTikeipevo eupavifetal pe Paon tov dyko
Tov kot to halo deiyvel ta onueio oto omoia Ppiokovrol o1 KOPLPEG TOL AVTIKEILEVOL OvVAAOYQ LE TN
YEOUETPIA TOV, GOV £VO POTOGTEPAVO.

H popoen mov ypnoyomoteitat kupimg ewvor 1 Surface.

Yy koptéha Preview vmdpyel pio ovamopaoToct) ToV aVIIKEIPNEVOD HeTa amo Kabe pubuion
OV TOL KAVOLUE. XTa KouTaKl deE1d EMAEYOLE TO GYNLA TOL BELOLUE Vo €XEL

>mv Diffuse opilovpe t0 ypdpa tov, v évtaot| (intensity) Tov Kal ToV TPOTO e TOV omoio Oa
TEQTEL N OKLA GE QTO.

Ymv kaptéha Specular opifovpe TNV KOTOTTPIKOTNTA TOL OVTIKEWWEVOL Kol TG Oa
gpeaviletor.

H xaptéra Shading €yel Tig 1010TNTEG TNE EMOKINGNC TOV OVTIKEUEVOD.

H Game Settings pvOuiletl tov tpomo mov o eppaviletan To OVTIKEIPUEVO KATO TNV SIEPKELN TOV
T VIO100.

H Physics pvBuiler tig Aeitovpyieg Tov ovTIKEWEVOD, Oivovidg TOv TN duvaTodTNTa Vo
GUUTEPLPEPETOL GAV £VOL AVTIKEILEVO GTOV TPOLYLOTIKO KOGLLO.

H xoptého Transparency oOiver v 1010tnta Tng Ol0QAVEWNS OTO OVTIKEIUEVO, TO TIO
dwdedopéva ot ypnon Toug ewvor ta Z Transparency kot Raytrace. H iur tov Alpha amo kdto deiyvet
OGO JOPAVES EVAL TO OVTIKEIUEVO.

Ye Kk0Pe oavtikeipevo pmopovpe vo PBolovpe o6co Material  Oéhovpe. Mmopodue va
YPTOLLOTTOLOVUE OTI010 LaG foreDel kKGBE Popd, 1| VO YPNCIUOTOMGOVUE TAVMD 0To VO TAVTOYPOVAL.

IMa va, to kdvovue avtd, yopilovue to avtikeipevo og Edit Mode, toekdpovue to onueia oto
omoia BéAovpe evo cuykekpluévo material Kot pe To kKovpmi Assign 1o epappolovpe. e Edit Mode
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Eava dnpovpyodue Eva véo material kot to epappolovpe Ko avtd pe Tov 610 TPOTO 6€ KAToo, GAA
UEPT) TOV 1010V OVTIKEIEVOD.

C4.2 Textures

Ymv Ewodva 79 éyovpe mv kaptéha Texture. Kot mdAr pio Aioto gpgavileton v omoio
UTOPOVE VO OLOYEPIOTOOUE, OTT®G B€Aovpe, koD kol va aAla&ovpe to Ovoua Kabe texture mwov
dnuovpyode. Amo ™ Aioto uropodpe va emhéEove Told textures BEhovpe va paivovrat.

Y10 medio Type éyovpe ddpopa £idn vpav, 6mmg ta. Clouds, Noise, Marble, Ocean, Wood kot
dipopa GAAa, To ool ypnotpomoobviot avaioya Le To Tt ven BEAovue va €xel éva avtikeipevo. To
nedio Tov Type e T0 0moio 0oYOAOVLOCTE TEPIGGOTEPO Eval To Image or Movie.

Y10 medio Influence omv emoyn Blend pmopodpe vo doré€ovpe pe mowd tpdémo Oa
avaxoTevovTol To textures peta&d tovg, av eival Tapamdve amo £va.

Avotlyovpe pio e1koOvo TG 0PECKEING LG KOl OUECMG ELPAVICETOL TAV® GTO OVTIKEIEVO. AV |
gWoOVa OpmG  Ogv epapudlel Téleln TAVD GE OLTO COUPOVE UE TN YEMUETPIO, TOV, OV EWVAL Yo
TapAdELYHa £va GUVOETO OVTIKEIIEVO, TOTE YPNGLULOTOOVLE [ dladikacio mov Aéyetar Mapping.

Ewova 79 - Texture

Sand Plane

Ortav épovpe éva amhd avtikeipevo, Oomwg givor to Plane tng Gupov vy mapddetypa, m
Sdudkacio Tov akoAovBovE Yo va Tov Balovpie texture etvon n e€ng.

Anpovpyodue éva véo material yio o Plane, tov divovue éva ovoua, undeviovue to Intensity
oto Specular yw va punv swvar aotpaptepd kor amevepyomolovue to Backface Calling oto Game
Settings dote va paivetat OLOKANPO TO AVTIKEILEVO KOTA TO TPEEO TOV TOLY VIS0,

21 GuVERELN OMoVPYOVUE Eva, VED texture, Tov divoupe éva dvopa, kat dtaAéyovpe To Image
or Movie. Avoiyovue pio gicovo Etoun M ene€epyacpuévn o€ Kamoo mpodypappo, tomwov Photoshop kat
OLTH VTOLOTO TOTOOETEITOL TTAV® GTO OVTIKEILEVO.

To amotédeopa yio TV aupo givon awtd g Ewkovag 81.

Téhog matdpe v emAoyn Pack an Image.

62



[Mtuyoxn Epyacio Tuqpoatog Mrnyoavikov [TAnpogopikng TEL Kprjtng

%) Blender™ [C:\Users\greeklover\Deskfop\mruxiaxn\blender files\fishfanklblend]

©

Ewéva 80 — dwapéd

o

powon Tov Plane g dppov Ewéva 81 — npocOfikn Texture mave oto Plane

C.4.3 UV Mapping / Xaptoypaonon

Water Plane

Y10 plane tov vepov mov eTaaue, emAéyovpe oto Materials to Z-Transparency:0,104,
dNAadN 10 TOGO dapavég Ba lvar TO AVTIKEIUEVO KOl TOV dDGUUE TIUN.

[No va kévoope v emedvelo tov Water vo gaiveral peaotiky], O tomobetnoovpe cav
texture oto Plane pio ewova, n omoio ewvor @TIOYHEVT 00 TOAAEG HIKPOTEPES EIKOVES, £T0L DOTE TO
OTOTEAECUO VO Elval 000 O PEOMOTIKO yiveTor. Tnv €wova ovtiv Oa T ¥PNOLOTOCOVHUE GOV
animation méve oto Plane ywo va éxovue v ywevdaicOnon g kivnong tov vepo.

Onwg eaivetar kot otnv Ewova 82, avoiyovpe mapdiinia pe to 3D View kot évav UV/Image
Editor.

Ytov UV/Image Editor avoiyovpue v gixévo mov Oa Pdrovpe cov texture. Emiéyovpe to
Plane kot kot e Edit Mode to kévovpe Unwrap. Ano to Texture tov Properties Editor, diaAéyovue
oav tomo to Image or Movie, kot avoiyovpe tnv idwa ewova. Xto Mapping dweAiéyovpe oto Coordinates
10 UV. Topa to texture paivetar méve oto Plane.

¥to UV/Image Editor, emAéyovpe to UV Layout tov Plane, pe to S umopodue va to
HEYOADOOVUE Kat Vo, T pkphvovpe. Kdvovtag to avtod, opilovue 1o mhg 0o paiveton mve oto Plane
to texture. Oco mo wovtd eivol to uéyebog tov UV Layout oto péyebog tov texture, téco mio
Aemtopepés paivetar to texture oto Plane, evd 660 10 pikpaivovue 1 UEYOADVOLUE TOGO YOAGEL T
avéivon Tov.

To va eriaEovue to animation, avoiyovue v kaptéia Properties tov UV/Image Editor,
natdvtog o N. Onwg eaivetor, oty Ewova 68 oto Game Properties toexdpovue 1o Animated kot
opiovpe to Start:1, End:99, Speed:2,toekdpovpe to Clamp X,Y «kou ta Tiles ota onoia divovue v
Tiun 10.

Ta Tiles ypnopomotovvtat yio va emavolaufdvetar évo. texture mapandve amo pio popés o€
éva object. Me avtdv Tov TpOTO UImopOvUE VO STUIOVPYAGOVUE Kivoduevo, textures.

Avaroyo pe ta Tiles mov épovpe opioet, puBuilovpe tig emhoyég tov Animated, amd moo,
uéypt mo1d frame Oa tpéet kou moéom Ba givon 1 ToydTNTA TOV.

Téhog to. Clamp X,Y 1o togkdpovpe, hote vo pmopodue vo peyolmoovue to UV Layout,
Yopic vo TeTpaymvileTal n eucova.
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[ Apoeo ]

¥ o T

| uc(w 83— sapoyﬁ Tov Transparency

Télog evepyomotobue to Transparency otnv kaptéda Materials kot pmopodpe va aArdEovpe
o ypdpoTe Tov texture énmg supaviCovioar mhveo oto plane, and v koaptéia Influence>Blend,
£xovpe dtolé€et To MiX.

Ortov motmoovpe 10 P kot Egxvioet va Tpéyel To mayvidl, TapatnpoOUe OTL 1] EMPAVELL TOL
Plane poialet pe v kivnon tov vepod.

Ship Mesh

IMa mo obvbeta avtikeipeva, 6mmg eivol to kapdpft, N dadikacio ivol Td ToAdTAOKT. LTO
KkapaPt Bo wpénet va faiovpe dAlo texture yuo to EOAvo pépog tov, dALO Yo To TOvid Kot T onpoic
Kol GAAO Yo Ta Kovovia Tov. Emeidn oumg kot avtd pepovouéva, dev ivol eminedeg emQAveELEg, aALd
Kol elval KaOUmLAMTA 1 KOAWVOPIKA, Yoo pueyodlvtepn okpifeto Oa ypNGUYLOTOGOVUE KOl €0® T
uébodo UV Mapping.

O1 vpég ypeldlovTal CUVTETAYHEVESG YOPTOYPAPNoNS Yo va kabopicovy g Ba epappoctovy
veouetpikd. H yoptoypaenon mpocdopiler mog Oo toAybei n von yopm omd 10 avTiKEipEevo.
Agitovpyel pe 1o va 0éter éva (egvyog amd OULVTETAYUEVEG Y. VO 0dNYouvV TN Oladkocio
yoptoypdononsg. Avtég ol cuvvietayuéveg Umopobv va mpoélBovv amd movtov, cuvinBwg amd TO
QVTIKEIEVO TAV® 6TO 01010 B0 EPaPUOGTOVV.

H UV yaptoypdonon eivar £vag axpipng tpomog yio va xaptoypagebel 2D mepieyduevo veng
o€ 3D empdveia. Kabe kopven tov mAéypartog éxet Tig ducég g UV ovvietayuéves ol omoieg pmopovv
va "A0ouv" kot vo, arhmBovv cov dépua. o UTopoHCaUE VO POVTOCTOVUE TIC CUVTETAYUEVES GOV U0,
YopTOYPAPNOT TOV AstTOVPYEL 6€ 0160146TATO EMiNedO.
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Apykd mnyaivooue oty kaptélo Object Data tov Properties Editor. Ztnv emdoyn UV Maps
dNUIOVPYOVE EVOL VEO OO TO + KoL TOV SIVOLLE Vo OVOLO. XTr GUVEXELD ETIAEYOVUE TO OVTIKEILEVO
Kot petapepdpacte o Edit Mode, 6mov emdéyovpe mold KOUUATIO TOV OVTIKEWWEVOD BEAoVUE Va
ocvpmeptrdpoovpe oto UV Map mov gptiaéape. I'a to kapdft etiaEape 4 UV Maps, éva yia ta movid kot
) onuaio, éva yuo To okapi Tov TAoIoV, va Yo Ta KOTApTIo Kot €va Yo Ta kavovia. Metagepdpoote
og Edit Mode ka1 yio k60 UV Map emiléyovpue Tig avrtiotoryeg meployés ne to epyaieio Circle Select
(C) ka1 Border Select (B).

(0) Americani:

dit Mode: 1% 0N Giobal 5| [ [w][E

va 85 — UV Unwrap

Ewova 84 — emloyn pe o C cuykekpilpéveov Ewco
onueiov 6to object

Aoy emiélovpe TIC meployég mov Béhovpe va cvpmepiddfovpe oe kdmoro UV Map,
gmAéyovpe amo to pevov tov 3D View Editor to Mesh>UV Unwrap 1| matdaue to U.
Mag eppaviovor dibgopa £idn Eedumhdpotoc: B4
o Unwrap: EedmAdvel £va avVTIKEILEVO OVAAOYX LLE TIG TAEVPES TOV
e Smart UV Project: yio mo ovvbeta ovtikeipevo ta kavel diodidotata e Pdaon éve onueio
EENTADLATOG TTOVL £XOVLLE OpioEL EUEIC
o Lightmap Pack kot Follow Active Quads: emionudvovue 6to avtikeipevo, moég akuég BEAovue va
glvat 00MY06¢ 6710 Eedimhmpo Tov
Cube Projection: mpofoAr Tov k0Pov o€ di661doTaTo TEPPAALOV
Cylinder Projection: mpopoin tov kvAivépov
Sphere Projection: mpoBoin coaipog
Project From View kot Project From View (Bounds): tpofoAr] Tov avTikelpuévov 0mmg 1o PAEmovue
€KElvN TN GTIYUN 0T0 TPLEOLAGTUTO EMITESO

Awéyovpe To Smart UV Project.

XwpiCovpe 1o 3D View Editor otn péon xon avoiyovpe éve UV/Image Editor otov omoio Ba
EUPAVICTEL TO OTOTELECUA TOV EESTADUOTOC GOV LU0l SIOSIACTUTN EIKOVAL.

Amo to pevov tov UV/Image Editor, notape UVs=>Export UV Layout. ‘Etot e€dyovpe to layout
HE TN HOPON .PNY, OOTE VoL UTOPOVUE VO TO ENeEEPYOCTOOUE HE £V TPOYPOLL Kot Vo, Tov BdAovpe
mhvo Kamowa eikdva cav texture.

H Ewdva 87 givan pia eixdva, mov @tidytnke og Photoshop yia va ypnoponombei cav texture tov
ovykekpiévov layout.
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ED - Blender Game

(0) AmericanWarShip

layout gtiaypéve g Photoshop

Ewova 87 —

Edit Mode 101 %

Ewova 88 — dnpovpyio 4 Material
>t ovvéyeta oto Materials dnuovpyodue 4 material oto omoia divovue to id10 ovOpOTO PE TOL
UV Maps (eikdva 88).
I kG0e Material mov dnpovpyodpe, propolue va dNUIOVPYNCOLUE TOVAGYIoTOV Eva Texture.
Mmnopovpue va ptidEovpe pia AMota pe Textures yio kd0e Material kot vo, TOUG SMGOVLE OVOULOTOL.
Emléyovpe to Image or Movie kot avoiyovpe v .png eikdvo, mov @tiagoue, 6T0 ToPAdEyo
pog, oo v Koptéla Mapping aidalovue to Coordinates dniadn tig cvvietayuéveg oe UV. Amo
Kkéto oto Map emdéyovpe to UV Map o610 onoio aviikovv ta aviikeipeva mov eneéepyoalOUaoTe.

66



[toyoxn Epyacia Turpatog Mnyoavikov [TAnpogopwrg TEI Kpnitng

Ewkova 89 — aihoyf] TV cvvtetaypévoyv og UV Ewéve 90 — dvorypa Tov layout mov
ypnowomomjcopns stov UV/Image Editor

10 moapdBupo UV/Image Editor avoiyovpe v giéve mov @riaape, yio va tn PAETOLUE Kot
eKel.

Ty S Stadkacio akorovBolue ko yio to vedroura UV Maps. I'a kéfe Eva dnpovpyodye
éva. material ko éva texture. Agov telei®Sovpe Kkdmolo To TomoBETOVUE TAV®D OTO OVTIKEIUEVO,
natdvTog To Kovumt Assign, dia avtd mpémel vo yivovton og Edit Mode. Amo to xovumid Select kot
Deselect, emAéyovton ndve oto avtikeipevo ta pépn ekeiva mov avikovv oto UV Map mov eivol
Swodeypévo.

| ls) SN Data

Wire Volume

Ewova 91 — n keptéha material og Edit Mode pe v emhoyn Assign

Ytmv Ewova 92 givan o1 4 Editors pe tig puOpiosic mov kavape yo to gpyaieio Object Data,
Material ko Texture Kot T0 TEMKO OTOTEAEGHLO.

Téhog 610 KLKA®WUEVO onueio oto mapabvpo Texture vdpyel evo kKovumi o omoio cdlel cav
TOKETO TO OVTIKEIUEVO 1 TO KOUUATL TOV OVTIKEEVOD, pall pe TV eikova mov Tomobeoope o€ ovTo,
Kotomy toekdpovpe to Pack As PNG. Mg avth ™ dadikacio 0tav Oo EEKiviioovpe va TpEYOVUE TO
Ty viol, 0o ELPAVIGTOVY Ol VOEC TOV AVTIKEIUEVDV.
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€ oue

Ewova 92 — o1 kaptédeg Tov Properties Editor wov ypnopomrorodpus yro morlhanha materials

C.4.4 Anotéleopna

To amotéieopa mov Ba €xovpe av epapudcovpe To Topandvem, oe OAOL TO OVTIKEIEVA TG
oknvNng pog Ba etvat owtd g Ewovag 93.

[ Blender (G

O i

: o

Ewova 93 — 1elko amotélespa petd omd T yprjon tov Materials kou Textures

C.5 Rigging

Onwc og 6la ta 3D mpoypdppoto étol ko oto blender pumopovpe va dOGOVUE KIVNTIKES
Kovotnteg o éva avtikeipevo. H dwadikacio pe tnv omoia to kdvovue avtd ovoudaletar Rigging.
2NV ovoia EMCLVATTOVUE £VOV GKEAETO OTO OVTIKEIUEVO, £TCL MOTE VO UTOPOVUE LE AVTOV VOl
TOV O1VOLUE KIVIIGELG KO YEVIKE VO, TO TOPOUOPPDVOLLLE.

Onwg eaivetoaw otv Ewdva 94 yio va mpocOécovpe évo Bone mnyaivoope 6to pevov
Add->Armature=>Single Bone. 'Etot Xto onpeio mov eivor tomobetnuévo to 3D Cursor Oa
eupaviotel to Bone.

To amotéheopla TG ELGAYMOYNG OTMOG OTIG TOPOKAT® EIKOVEG:
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® ol e obal % |gs

Ewoéva 95 — tomo0étnen} Tov 6710 object

Ewova 94 — wpooOikn evog véov Bone

Me 1o Bone toekapiopévo, avoiyouvpe to mapdbopo twv Properties.

Apykd mnyaivovpe oto tab Object Data, 6mov ynid pog dgiyvel 10 OVOHA TOV GAVTIKEWWEVOL
oV TPocHicae Kol T0 0moio pmopovue gueic vo oAhGEovpe amd kdtw. Xty koptélo Display
umopobe vo, emhééovpe TV popen mov Béhovue vo €xovv To Bones. Apyukd ypnGULOTOO0UE TV
Octahedral popen, n omoia eivar n mo gdypnotn Yo eneéepyasio. Otav olokAnpdoovue to Armature
umopovpe va emdéEovpe ™ Wire popen, €tol ®ote vo givor mo Swkpitikdé o Bone méve oto
OVTIKEIUEVO.

2ta checkboxes and Kdtm ToeKdpovpe TL BELoVLLE VO QaiveTOL TNV DOPO TOV OOVAEVOVLLE LE TOL
Bones. EmAéyovpe to X-Ray dote va Aémovpe péoa and 1o avrikeipevo to Bone kot va propovie
7o £0KOAN VO, TO TEWPAEOLLLE.

(2 1 01%IS ok

0 - L _ Ewéva 97 — enelepyacia Tov One o€ 2 OyeEIg ToV
Ewoéva 96 - Object Data Tov Bone 3d View

Kavovpe Split o mapdbuvpo 3d View éto1 dote va AEmovpe 300 TAEVLPEG TOV OVTIKEUEVOD,
onmwg paivetar oty Ewdva 97 éyovue 10 éva mapdbupo tnv dyn Right Ortho (hotkeys: numpad3 &
numpad>5) kot oty dimho tov v Top Ortho (numpad7 & numpad5). BAénovtog étot dvo Oyelg,
oépvoupe to Bone ot 6éom mov BEAovpe kat To TEPIOTPEPOLLE EMioNG OTT®G MG eEvrnpetel. Ao To
Tab Properties (N) otnv kaptéia Transform Brémovpe 060 10 £XOVUE HETAKIVAGEL 1| TEPIOTPEYEL.

I"a va cvveyicovpe v dnpovpyic. Tov okeAeToD, petapepouacte oe Edit Mode pe to Bone
eMAEYNIEVO. XTNV TapaKaTo ewova PAémovpe 6t1 og Edit Mode pumopotpe va emiééovpe 1o Bone og
Tpio SpopETIKE onuEia.
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Ewova 98 — onpueio mov propodps va emié€ovpe to bone o Edit Mode

Y10 mp®TO onueio, dadéyovpe to Bone amd to Root 1 Head tov Bone. Amo 1t Bdon tov
oniadn. Tn PBdorn pmopodpe povo va TN petakivicovps, aAidlovtag €Tot 10 onueio amd to omoio
Eexwvael to Bone yopig dpmg avto va ennpedletl v katdAnén tov (Tail).

>10 0evtEPO omueio, dwAéyovue to Body amd to Bone, doAéyovue dniadn oAdkAnpo To
Bone ka1 €161 0Tt aAlayr| Kdvovpe og avTtd Ba Yivel Kot 6g OAOKANPO TO OVTIKEIEVO.

Y10 1pito onueio, SwAéyovpe 1o Tail, v xotdAnén Tov Bone. Mmnopovue vo 10
petaxwvinoovpe oAlalovtag to mwov telelmvel To Bone ywpig dpwmg va emnpedletat To Root tov. Emtiong
o6 to Tail umopovue va meprotpéyovpe to Bone yopw and tov d&ova peta&d Head ko Tail.

I'o va egrexteivovpe tov okeletd pag, mpémel va mpochiécovue éva kawvovpylo Bone. Avtd
dev Ba yiver amd to Add->Armature->Bone Eavd, yoti étot Oa dnuovpynoovpe éva véo Armature.
Eueig 0éhovpe va ptria&oovpe éva véo Bone 1o omoio va gival cuVOESEUEVO OO TO TPMTO Kol VO
e€aptator amd avtd, Omwg Asrtovpyel kol évag okeAetdc. o va 10 metdyovpe avTd, €XOVTUG
emleypévo 1o Tail Tov tpdtov Bone natdue oto pevod Armature=> Extrude 1 natdpe to E ot pe 1o
movtikt divovpe v Kkotevbuven mov Béhovue va €xel to véo Bone. Ta mepiocdtepn akpifela
puropovpe vo emAéEovpe kot Tov dEova otov omoio Béovpe va emextadel to véo Bone, matdvrog m.y.
E kot y (Ewova 99)

Ewéva 99 — dSnmovpyia véov bone mavo otov y aEova Ewcéva 100 — ovépata terv bones

Me 1ov id10 Tpdémo pmopodpe va mpocBécovpe kot GAAo Bones mpog omowo katevBuvon
0élovpe. Kabe Bone mov mpootiBeton, eEaptaton omd To mponyolpevo tov. Xty Euova 86 paivovron
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to Bones mov dnpuovpyninkav pe to ovopata tovg, kot 6to Topdbupo Outliner to didypoppa pe Tig
oyéoelg peta&d tmv Bones.

‘Evag dAhog tpémog va @ridovpe moAAd Bones to omoia va 0éhovue va  eivon
gvBuypappicpéva oe éva dova etvar apod Pdiovpe to Tpmdto Bone va to peyokdcovpe 6co BEhovpe
Vo, givot 0 oKeLETOG pog Ko 6T cuvéyeto va tathoovpe Armature=>Subdivide (W) kot va yopicet
ota dVo 10 Bone. Oceg popég 1o matdpe tooeg popég vrodioipei To Bone.

AoV TELEIDOOVIE TOV GKEAETO, HUMOPOVUE VO EEKIVIICOVLE VO TOL divovpe kwvnoelc. [Ipy
ovtd OUMG, TPETEL VO, TOV EVAOGOVUE LUE TO OVTIKEILEVO, £T0L MGTE VL EMOPA GE AVTO OTOV KIVELTOL.
®a kdvovue tov okehetd parent tov object. Emhéyovpe mpodto 10 avtikeipevo kot pe to shift
noutnuévo emAéyovue kol tov okeAeto. Ilaue oto Object->Parent->Armature Deform With
Automatic Weights 1 evoAlaxtikd mataue Ctrl-P=> Armature Deform With Automatic Weights
(Ewova 101). Me avtdv tov tpodmo kavape to Armature parent tov aviikeiévon ue kabs Bone va
emnpedlet avtopato v meployn tov Object otnv omoia Ppioketor. v Ewova 102, PAénovue 610
Outliner 6t todpa péco oto Armature PBpioketor Kot to avtikeipevo, 1o omoio givor to fish. Zto
napaBupo Properties pe emheypévo 1o avtikeipevo mnyaivoope oto Tab Objects kot otv Koptéla
Relations pAémovue mo1d givar to Parent tov avrtikeipevov. v mepintoon pag wov to Parent givol
Armature npénel va aArdEovpe to Parent ce Armature 6nmg oty Ewova 103.

¥ Double Sided

Ewoéva 101 — gmhoyn Tov gidovg Tov parenting | {Ee
mov Béhovpg Ewéva 102 — parenting tev bones tov armature

© b er% Sl

:

XYZ Euler

Ewoéva 103 — arhayn Tov Parent e Armature

Mo va etid&ovpe v kivnon Tov OKEAETOD Kol GPO TOV OVTIKEIUEVOL, TPEMEL £XOVTOG
emAeyuévo 1o okedetd vo odlaEovpe omd Edit mode oe Pose Mode. Xe Pose Mode umopovue vo
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KIVIOOVLE TO GKEAETO 1 VO TOV TEPICTPEYOVLE, MOTE VO, SOCOVLE TNV aicBnon g kivnong, yopig
opm¢ va, adAdEovpe v Béon mov tov dmacape oe Object Mode.

210 GUYKEKPEVO TTapddeypa, 1 kivnon tov Bones eivar mepiotpogikny otov z a&ova. 't
avtd Tov Aoyo Ba adrdEovpe to View og Top Ortho (numpad?7).

Enidéyovpue 10 Bone mov BOélovpe va mepotpéyouvpe. o peyoivtepn oaxpifea Tig
nEPOTPOPEC  TIC Kavape omd to Properties (N)->Transform->Rotation. BAémovpe 611 Omemg
neploTpéPetal To kébe Bone, TeploTpépeTal Kot TO AvTIGTOLYO TUNLLO TOV AVTIKEHEVOD OV Eivarl YOP®
tov. Ernlong mapatnpovpue 61t to emdpevo Bone tov onoiov givon parent akorovbei v 1d1a kKA o).

IMa vo Kataypdyoope Ty Kivnon 6To avTiKEipevo €161 ®oTE va Kiveitan 0mote B ove, Oa o
Kkévovpe Animation. Apod amopacicovpe g Oa glvon ot Kivioelg Twv Bones kot pe mola oepd Ha
yivovtal, o arxoAovONcEL 1| KaTaypapt| TOVC.

Kavovpue Split To mapabvpo tov 3d View kot Oo avoiovpe éva Timeline. PuOuilovue moca
frames 0€éAovpe vo Exoue.

G FEEEFEE s

Ewéva 105 — editors yra tnv drwadwkacio kataypagns tov frames

I k60e Bone mov Béhovpe va mepiotpéyovpe, Ba Pdrovue keyframes oe kdbe frame oto
omoio Bélovpe va Exovpe aldayn Kivnong.

¥to0 frame 0 Ba Pdlovue éva keyframe pe v oapyikn Kotdotoon tov Bones. 1o medio
Rotation tov properties 6o kévovue de&i ki kar Insert Keyframes. ITopatnpovpe 0t ta tedio pe Tig
Tég Tov Rotation xabmg kat to frame 0 tov timeline éywav kitpva, avtd onuaivel 61t to Keyframe
tonoBetnOnKke Y10 T0 cuykekpiuévo Bone pe tig ouykekppéveg tipéc. Ty Ewova 106 paivovrol ta
keyframes mov éyovv pmet yio kGOs Bone kot ot Tipég tovg.
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ol =W S]| (55 Blender [C:\Users \greaklover\beshtop \mruxianm\blender file.. (o]

oy (o8]

Ewcova 106 — tipéc tov keyframes ya ka0s bone

To o Aemntouepn avalvon tov animation, aAldlovue to Screen Layout amd 3D View og
Animation.
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u«')u 107 — Animaton Vew

Ta 600 véa mapdBupa mov PAémovpe eivar to DopeSheet Editor kot to F Curve Editor.

10 10 DopeSheet Editor éyovue pio Aiota pe Tig gvépyeieg mov €ywav o€ kdbe Bone. [Na
ké0e Bone mov emiéyovpe oe Pose Mode emiléyoviar kot ou avtiototyeg evépyeleg ot AMota. Ot
eVEPYELEG QVTEG lval M EPIOTPOPES TOL £yvav o€ KABe G&ova yuo kdBe Bone. Almia ond ke
gvépyelo gppaviCovror to keyframes mov £yovue Barel. Oca givarl evopéva e TV TOPTOKOAL Ypouun,
dev aAralel M T Tovg KaTd TN ddpkeln Tov animation. Emiong og avtov tov Editor umopodpue va
petaxwnoovpe totovrog o G to keyframes, emdéyovtag pe de&i KAk 6co Béhovpe M pe A Oha,
UTOPOVLE VO TO KAVOVLE AVTLYPAPT — EMKOAANGT), VO TO S1OLYPAYOULLE.

>1ov F Curve Editor (Ewdva 108) eppaviletat évo didypoppo toyxdTTog-omdeTactS T0 0moio
kaBopiletl v TaydINTO KoL TV EMTAYLVON TOL avtikeipevov. Ta onueia mov eaivovtol o avtod givol
ta keyframes. ' vo. aAAdEov e TV ToOTNTO KOl TV EMTAYVVON TOV AVTIKELUEVOD, TTelpdlove TNV
Aompn KOUTOAN ToL dtaypdupatoc. o va otabeponomcovpe v taydTnTo petald dvo keyframes, to
gmAéyovpe kol and 1o puevod mataue Key-> Interpolation Mode—> Linear kdvel étot tnv ypauun
gvbeia, ofnvovtag v emtdyvvon.

Ewoéva 108 - F Curve Editor
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C.6 Game Logic
C.6.1  Game Logic Editor

Ewoéva 109 - Game Logic Editor

Ymv Ewova 109, BrAémovpe oto oplotepd éva medio pe to ovopo Properties. Amd €dm
UTopoVvE VO TPOGHEGOVE GTO TTaLYVISL WOOTNTEG OGS Y10, TAPASELYIO TO UETPTUO TOV TOVI®V KOl
) ddpketn (ong Tov maiytn. [pdeovpe T0 dGvopa ™G 1010t ToG, ETAEYOVUE av 1 LeTaPAnTn Oa sivol
L0 OKEPOLD, TPAYUOTIKY, N AOYikn Tun, opilovpe oav Ba apyilel amd to 0 1 omd KAmOOV GAAOV
apfuod, kot matdvtag to (i) EMTPENOVUE KATA TO TPEELO TOV O VIS0V, va eugaviletal otnv 08ovn
To Property.

And

or

Nand

Radar

Ray
Touch
Ewéva 110 - Sensors

C.6.2 Egappoyn Game Logic ¢ Objects

IMa to Toyvidl, BéAovue va ddcovue Tig eENG EVTOAES OTA AVTIKEIIEVH LOG:

To yapt va petakveitor mpog pior KUKAKY katevbuvon Kot UOAG OKOVUTAEL TN YLOAX VO
otpifet aAlod. Tavtoypova va Kiveitar kot To armature mov tov PaAope.

Ta @OKia va KouvAve TOV OTAGHO TOVG, GOV Kivno.

O1 KGUEPEC VO LITOPOVY V. TTNYAIVOLY UITPOC KoL To® Kot vo, oTpifouv de&id, aplotepd, Tavm
Kol KATO.

To KopdKt eKTo&edeTal Ao pio KAUEPO AVAAOYOL LLE TNV QOPE OV £YEL TAPEL KAOE GTIYUN.

To aykiotpt eivar aveEdpmro kot propet va kivn0ei de€id, apiotepd, Tavm, KOTm, KoOMG Kot
UTPOOTA Kol Tiom.
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Yav eQé, £xovpe TPochEcel PLOAAIdES 01 0Toleg KATA T S1GpKELD TOV T VISl Ba Byaivouv
amo ta yapio. Tig puoaiideg tig pridEaue pe UV spheres tig omoieg og Edit Mode, moAlamlacidoape
Kot oA GEape To péyebog toug. 'Yotepa oe object mode, tovg mpochécape material 6mov Tovg ddoape
transparency. Télog 660 Ba tpéyet To mayvidy, BEhovpe va eppaviletal otnv 08dvn, vag HeTpnTiG HE
TOVG TOVTOLG OV Palevet o malyTnG.

IMa tov petpnty, oAAd Kot yio. TNV Kivion Tov Kopep®v, 8o ¥pnoIUOTOINCOVUE OVTIKEIEV
tomov Empty.

a. Camera

Ye k@0e wkapepo Ba tomobenoovpe éva Empty. Emdéyovpue v xduepa kot motaue Shift
S->Cursor To Selected. Etot 0 3d Cursor 6o torobetnbei otn Bdon g Kauepog. Xtn cvvéyeto, amd
tov Info Editor noataue Add=>Empty->Plain Axis. Balope étot éva Empty ot Bdon g kapepog.
21 ovvéREln, EMAEYOVTOG TPAOTO TV Kauepa Kot petd pe Shift to Empty, motape Ctrl P->Set
Parent To Object, kdvovtog étol o Empty parent g kduepag. Mg autdv tov TpOTO OTL Kol Vo
Kkévovpe oto Empty Ba £xet kou enidpacm oty Kapepa.

I'a kabe Empty mov Bélovpe oe k4B kduepa, mpénel va Tov divovpe Kot £vol OVOLLOL TOV Vol
TOPUTEUTEL OTNV KOUEPX, £T0L MOTE Vo €ivol o €0KOAO G6TO YEPoUd tov. [lapdderypo yio v
Camera01l ¢yovpe To Empty01.

Camera0l

o v xivnon prpog ko micm tov EMpty kou g kapepag, ypnNOLLOTOMOUUE TIG ETOULES
gvtoléc mov €xel o Game Logic Editor, evd yio TNV TEPIOTPOPIKY KIvNGT TNG, YPNOLUOTOICUUE EVa.
script o Python pe tov Text Editor.

o v kivnon umpootd, Ba ypnoyonomocovpe to mAnktpo W. Zto medio Sensors Oo
duré€ovpe to Keyboard xat oto mhaicto tov Key, 8o motioovpe 1o W. Eto medio Controllers 6o
draré€ovpe To And ko oto Actuators to Motion. 1o Motion, fa emdéEovpe to Simple Motion kot
™V TN g petafoing g kivnong Ba v yphwyovpe oto medio Loc. Ta X, Yy, Z givat ot dEoveg oTovg
omoiovg yphpovpe tn petafoin g kivnong. To L oto mhdt, to emAéyovpe av BEhovpe n kivnon va
yivel otovg local 4Eovec, arhing Oa yiver atovg global.

Onwg gaiverar otnv Ewova 113 Balape va yiverar kivnon katd 0.5 otov y d&ova tov Empty
Ko emAé€ape to L agpov kot to Empty eivar pubispévo otoug Local a&oveg (Ewova 114)

T'o v xivion Tpog ta Ticw, avoiyovue nditl évav Keyboard Sensor, évav And Controller kot
évav Motion Actuator. Atodéyovpe t0 TANKTPO va givarl To S Kot 1 kivnon mov Ba Kavel va ivot
Simple Motion ctov y Local d&ova, pe tipn -0.5.

Téhog evavoupe pHeta&d ToVg T0 KOLTIA.

Sense

Ewova 113 - poBpicsis o tnv kivnon g Camerall péom Tov Empty01 ..

76



[Mtuyoxn Epyacio Tuqpoatog Mrnyoavikov [TAnpogopikng TEL Kprjtng

o e

Ewova 114 — alhayn Tov a&ovev Too Empty01 og Local

ITape oto 3D View kar dwdéyovpe va BAémovue péoa amo v oyn tg Cameral0l. Av
matioovpe P, yio vo tpéet 1o maryvidl, Ba dovue o6t pe ta mAnktpa W kot S, o mpoywpdue pumpog
Kot Too.

IMa va prid&ovpe v meproTpoPikn Kivnon mov Ba divel to movtikt Ba ¥pNGYLOTON|GOVE TOV
Text Editor otov omoio péoa Oo Pdrovpe to Script yio v kivion tov mouse (Ewodva 115). Tov
Sivovpe 6vopa “Camera0l movement”™,

FxX Ean

t ywo Tqv kivien g Camera0l

5]

Ewéva 115 — Python Scrip

T vo Tpé€et o scirpt tng Ewovog 115, npénet va to Bdiovpe otov Python Controller tov
Logic Editor, kot 6o o cuvdécovpe pe d0o Sensors. ‘Evav Mouse pe Mouse Event to Movement ot
évav Always, 6ntmg eaivetar oty Ewodva 116. Tov Mouse Sensor tov ypsialdpacte yio vo deiovue
Ot 01 evToAég Tov Scirpt Bo ektedovvtan amo to Mouse, evéd tov Always Sensor yia va. ektehodvion
ovveydg. Otav ypnoyonotovpe Python scirpt cav Sensor, dev ypelalopaote, Actuator.

Ewéva 116 - pvOpiceig yra tnv kivnen g Camerall péoo Tov Empty01 .
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Ewévo 117 — pvOpicsig yia v Kivm] CameraOl péc® tov Empty01

2mv Ewova 117 PAémovpe dAleg 600 cuvdéoelg mov Parape. Me to TaTUe TOL TARKTPOL 2
oav Sensor, kévoupe trv Camera0l vo aAldlel pe Tnv Camera02. Ztov Actuator ypnGLHLOTOGOLE TO
Scene oto Mode Barape to Set Camera kot cov kapepa opicape v Camera02.

b. Avrtikgipevo — Kopaku

To kapdkt Oa ekto&evetar amo v Camera0l, kdbe @opd mwov Bo BEXovue va meThOLE
Koo yapt.

To vo 10 kGvovue avtd apyikd tomobetnoaue 10 Koudkl o évo GAlo layer amo avtd tng
Kauepag. EZtnv kauepa mpooBécoue éva dgdtepo Empty oto omoio otov Logic Editor Baraue cav
Sensors 10 Mouse pe Mouse Event to Left Button kot to Tap emiheypévo, ko to Delay pe
evepyomomuévo o true to Pulse Mode, pe Delay:2 kou Duration:1 kot toekapiopévo to Repeat. Tovg
Vo Sensors tovg evooue péow evog And Controller ue tov Edit Object Actuator, tov omoiov n
evépyela Ba eivon va mpochétet Eva Kapdkl ot oKNnv.

Ewoéva 118 — pvOpicsig yro Tnv Kivijo1 TOV OVTIKELPREVOD KOPAKL

C. Avtikeipevo — AykioTpt

To aykiotpt @aivetar amo v Camera02 kot givar aveEdpmto omo ovtiv. Me éva Script®
opifovpe v kivnon mov Ba kdvel péca 6To gvudpio.

Ewova 119 — pvBpicseig orov Logic Editor ywa to aykictpt kot to Script mov ypnoiponorei. .
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d. Fish

Yy Euwova 120, BAémovpe Tig eVTOAEG VoL OAEG TIC EVEPYELES TTOL BEAOVLE VOl KAVEL.

e Me tov Always Sensor kot tov Motion Actuator opilovpe pion cuvexopevn kivnon, kotd 0,20
HOVASEG GTOV TOTIKO GEOVO Y TOL OVTIKEUEVOV, KOl Wit GUVEXOUEVT TEPLOTPOPN Kotd 1° otov
Tomkd GEova Z.

e Xtov Collision Sensor, Balovue to Material glass dniadn ™ yvdia, Aéyovtag £tot 0Tt O vIEGPYEL
KOmola avtidpaot Otav akoLVUTAceL To avTikeipevo avtd. H avtidpaon Oo givar n mepiotpoeny 45°
otov local a&ova y, mov to opilovpe pe Evav Motion Actuator, otov omoio emiAéyovpe Tov THTO
Character Motion.

e Mze tov Random Sensor kot to medio Seed pvbuiopévo pe pio T €ktdg tov 0, dnuUovpyovUE
U0V TAANODE e TOVG 0ToioVE Kavoupe To avtikeipevo Bubbles va Byaivel amo 1o avtikeipevo
Fish. O Actuator mov ypnowonotovpe givar o Edit Object tov omoio kdvovpue Add Object. Xto
nedio Object Baovue to Bubbles, pvBuilovpe o Time yio tov xpdvo 1o omoio o eppaviletor Kot
opiCovue kou pio TayvTnTe 50 otov Global d&ova z, dote va ddoovpe pio Kivion mpog to. Thve.

e O sensor Near givot yio to Hook-Mesh kot to Kamaki. Xto nedio Property éyovpe BaAet to Hook.
Omnote axovundel o Fish, €éyovpe dvo evépyeies, apa dbo Actuators. O évag Actuator eivor o
Message otov omoio Balovpe cav subject to unqvopoa points, to omoio Ba kaAécovpe yuwr ToO
UETPNUO TOV TOVI®V KOl TV TOpoyoyn evog Nyov, omote éva avrtikeipevo 6mmg to Fish 1o
axovurdel to Hook-Mesh. O devtepog Actuator ivar o Edit Object, tov omoio éovpe pvBuicet oe
End Object, 6tav dniadn Ba to axovurdet, to Fish Oa e&apaviCetat.

Ewova 120 — pvOpissig Logic Editor yie to Fish

e. Armature

H ewodva 121, deiyvel tig eviolég mov ypnoiporotobvor yioo to Armature otov Logic Editor.
Yov Actuator, £xovue Bdier tov Action kot £yovpe emhéer to Play, kou to dvopo tov Armature tov
avtikeipévov. TTodd onuavtikd ivar va drovpe oto Start ko Stop, ta frames ta onoia £xovpe opioet
katd o Rigging Tov Armature.
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Ewova 121 - pvOpiceg Logic Editor ye to Fish Armature

Tnv 1d1a Swdkacio, kdvovpe Yo kdBe Armature, Tov £yovpe YPNGLOTOMGEL, GTO TALYVIOL.

f. Text— perpnmig MOVTOV

Ta Texts givar avtikeipeva, 6mwg ta Béziers curves ta omoia nepiéyovv keipevo. Emttpénovy
va dnpiovpynBel 6160146TaTO 1 TPIGOAGTATO KEIEVO, e SVVATOTNTO LUETAKIVIONG, TEPIGTPOPTS KAl
OA®V TOV 1810THTOV 7oV £(0VV Ta vTolowto aviikeipeva. Xe Edit Mode pmopovpe vo odha&ovpe o
nepileyouevo tov kewévov. Mg alt C o Object Mode pmopobpe vo petotpéyovpe éva Text oe Mesh.

Oa ypnowonomcovpe o Text ywo 1o pérpnue tov mOVIOV Tov mToayvidov. Apyikd Oo
dnuovpynoovpe pia véa oknvi v onoia Ba ovopdosovpe SCORE, o avtnyv Ba mposbicovpe pia véa
Kauepa 1 omoia Bo kortder katw. Ipocbétovpe éva Text to omoio oe Edit Mode 6o adld&ovpe oe
“Score:”, dimha Bo Barovpe Eva véo Text mov Ba eivor To Points kat to omoio Oa adidEovue og 0. Kot
ta dV0 Ba To LETAKIVICOVHE TAV® aptoTePd OTmg PAEmOLUE Ao TNV KAUEPQ.

Ytov Properties Editor omv kaptéia Material, dnuiovpyodue éva Material kot yio tor 800
Texts ko toekdpovpe to Text oto Game Settings. Ewkova 122

Ewéva 122 — ONUIOVPYia GKNVIS Y1 TO HETPNILO TOV TOVIQV

>tov Logic Editor, 6a kévovpue to Text Points va av&dvetar katd éva, kdbs @opd mov t0
Hook-Mesh ayyilet éva Fish.

Onwg @oaiveton otnv  Ewodva 123, Ba ypnowomomocovue to Tab Properties ywo va
npocBécovpe éva Text Game Property to omoio £xet To dvopa Text kot eivar Evag aképailog aplOpdc.

Ba ypnowomomocovue évov Message Sensor otov omoio Ba Balovue cov Subject To point.
"Etot Ba. evepyomnotel évav Property Actuator otov omoio aiddlovpe to Mode oe Add, Balovue oto
Property to Text kot oto Value to 1, dnhadn opiCovpe va yiverar mpécbeon katd 1, oto N vdpyov
Text.
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= Blender™ [Fr\New folder\aqua37.blend

Ewéva 123 — popbissig Logic Editor ya tqv avEnen tov points

g. Empty- FishtankGame

Xpnowomnotovpe évo Empty 1o omoio ovoudalovpe FishtankGame. Xtnv Ewova 124 Biémovpe
T1g pubuioeig yo tov Logic Editor.

Ewova 124 — pvOpicsig ywishtankGame

Apywcd oto Properties Tab, éxovue @tia&etr £va Property pe to 6voua sound, to omoio givat

Boolean kat &yt apywn T false.

e Xtov Always Sensor kat Tov Scene Actuator, éxovpe pvOuicet to Mode ce Add Overlay Scene, kot
oto Scene &yovpe Paiet v oknviy SCORE. Etol mévta dtav tpéyovpe o moryviol, Oa gaivovtot
Tave aplotepd otnv 006vn ta dvo Texts g oknving SCORE.

e Mze 1ovg dvo Keyboard Sensors, omote matdue to 1 1| 10 2, NAodn ONOTE PETOPEPOUOOTE
avtiotoryo otigc Camera0l ko Camera02, avoamapdyetar évag foc. Avtd 1o opilovue omo Tov
Property Actuator otov omoio Balovpe oto medio Property to sound mov @tidéope mapomdved Kot
oto value ypdaoovuye true.

e Balovue évav Property Sensor. Xto medio Property, palovue to sound, oto value ypagovue true.
Omote 10 sound eivar aAndéc 1ote avamopdyetor évag Mo, tov omoio Palovpe pe tov Sound
Actuator. Avoiyovpue éva apyeio Nyov, kot to Play Mode to kdvovpe Loop Stop. ‘Etot cuvdéovpe
TOV N0 UE TG 0V0 TOPUTAVE® KANEPES.

e Xtov Message Sensor Balovpe oto subject tnv T point, Tov ypnoiponotovpe 6mote o Hook-
Mesh ayyilet éva Fish. Onote yiveton awto, pe évav Sound Actuator, Balovpe Evav véo 1o va
axovyetat kabe popd. Xto Play Mode emiléyovpe to Play End.
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i.  Python script yie. tqv kivnen T Camera01 1!

from bge import logic as G !
from bge import render as R
from bge import events
from mathutils import *

scene = G.getCurrentScene() 2
obj = scene.objects["Empty01"] 3

speed = 0.01 4
sensitivity = 0.0003
smooth = 0.7

cont = G.getCurrentController() >
owner = cont.owner

" m 6
Mouse = cont.sensors["Mouse"]

w = R.getWindowWidth()//2

h = R.getWindowHeight()//2
screen_center = (w, h)

. 8
keyboard = bge.logic.keyboard
JUST_ACTIVATED = bge.logic.KX_INPUT_JUST_ACTIVATED

if "oldX" not in owner: ’
R.setMousePosition(w + 1, h + 1)

owner["oldX"] = 0.0
owner["oldY"] = 0.0

10
else:

scrc = Vector(screen_center)
mpos = Vector(Mouse.position)

X = SCIC.X-Mpos.X
Yy = SCrC.y-mpos.y

owner['oldX'] = (owner['oldXT*smooth + x*(1.0-smooth)) 1
owner['oldY'] = (owner['oldY T*smooth + y*(1.0-smooth))

X = owner['oldX']* sensitivity 12
y = owner['oldY']* sensitivity

owner.applyRotation([0, 0, x], True) 13
owner.applyRotation([0, -y, 0], True)
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o 14
R.setMousePosition(*screen_center)

if keyboard.events[bge.events.RKEY] == JUST_ACTIVATED: =
owner.worldOrientation = [0, 0, 0]

1. Ewoaywyn tov BipAodnkov pe 11 kKAdoelg mov Ba xpnoipomomcovpe, ®oTe 10 SCript vo pumopei va
aAAniemdpaoet poli Tovg.
To Logic avagépetal otnv khdon tov Asttovpyidv tov Game Logic, to Render oty k\don yia v
AOO0GT] TOL TOLYVISLOD.
To Events yw ) ypion tov sensors, kot to Mathutils mapéyst apocPacn oe pobnupotikés pedddovg.
Ta G ko R givan otabepég Tig omoieg opicape GGTE Vo HTOPOVUE VO OVOPEPOLUCTE OTIG KAACELS
Logic ka1t Render o gbxola.
To bge onpaivet 6t propodue va £xovpe tpdoPacn otig Asttovpyieg Tov Blender Game Engine.

2. Opilel v tpéyovca oknvi mov Ba ypnotponomel kot tng divovpe 1o Gvopa SCENe.

3. Opilovpe 1O aVTIKEILEVO TG GKNVNG TOL B0l YP1CILOTOGOVE Kol TO TomofeTovpe oty HeTafAnTY
obj. Apa 1o obj avtitpocwmredel to Empty0l.

4. Opilovpe tpeic petafANTéG Kot TOVE SIVOLLE TIUES.
H speed sivar yio v taydmto mov Oo éxel  kauepa, n Sensitivity v ypiyopn avtamdkpion oTiG
KIWNGELS TOV TOVTIKIOD Kot 1] SMOoth trv opoddtnta dote vo notdletl peaiiotiki 1 kivion.

5. Tevikn Aertovpyio n omoia mwaipvel tov controller tng Python tov cuvdéel pe 10 cuykekpiuévo script
g Python kot to anotéheopa to amodnkevel oty petafint cont.
X petaPAnti owner opilovue Tov mapamdve controller, gival avt mov exnpocwnel To avrikeipevo
o710 omoio Balovue o script dniadn oto Empty01.

6. Aivovpe T ot petafAnt pe to 6vopo Mouse, to 6vopo Tov SENSor mov eivar cuvoedepévo oTov
controller.

7. Tw to rendering opiovue 600 petapintéc.
Znv W divovpe v axépaia Tiun og pixel Tov mTAdtovg Tov mToapaddpov mov TpéyEL To ToLyvidl 614 Tov
2.
Ytv h divovpe v avtiotoryn Ty Tov VYovg Tov TaPAHHPOL.
v uetofAntn screen_center Sivouvpe TV TN TOV GVTIOTOEL 6TO KEVTPO TOL TTapaddpov avTov.
Xy ovoia ywpilovpe T0 Topabvpo 6N péoT £ToL DOTE Vo EEPOVE TOVS AEOVESG KOl TAVMD G aVTONG
Vo OpIGOVE TIC KIVIGELG TOL MOUSE.

8. Oa ypnoipomomoovue cav Sensor kot to mAnktpordyro. H petafinti keyboard Oa yepileton v
gicodo g evrorg. H JUST_ACTIVATED s&ivoarw petafint m omoio evnuepdvel mwote pia
KOTACTAOTN £lval EVEPYOTOMUEVT).

9. OpiCovue dVo mpoocwpwvég petafintée, tig oldX ko oldy.
H oldX evvoei v opilovtia B<om tov Tovtikion kaim oldY v kébetn.
Me v if ehéyyovpe av 1 oldX dev avikel otnv owner, gléyyovpe dnAadn ov 1 opilovtio Béomn tov
TOVTIKIOV, deV TpEYEL e Tov controller oto script.
Av gival owot0, T0TE 1 060M TOL MOUSE KOTA TO TPEEWO TOV TaLyVIdoD, Bo avénbel katd évo pixel
Kol otov oplovTio Kot atov kdbeto dEova.
Emniong ot petafintéc oldX kar oldY Oa avijkovv mAéov oty owner, dpa kot 1 opiiovTia Kot 1 KAe
0¢om Tov Tovtikion Ba Tpéyovv pe tov controller oto script.

10.Av eivar AdBoc, dnradn av aviker n oldX otmv owner, tote divel otnv petafAnty SCrc v
SLOVOGLLOLTIKT TLUT TOV SCreen_center.
Eniong otn petafAnti mpos,divetol n dtavocpotikn Tur tov Mouse.position.
Mio véa petaPAnti X moaipvel TV T TG OOVUCUOTIKNG TIUWAG Tov Screen_center peiov g
dravuopatiknig TG tov Mouse.position, to 1610 yivetar avtictorya kot og Pid véa Y.

11.01 600 gvTOAEG £XOLV VO KAVOLV LE TNV OHOAOTNTO TG KIVIGT S TOL MOUSE 6Tovug d10 AEOVEG.
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12.EvtoAég yio tnv evaictnoio Tov mouse dtav Kiveitat.

13.H petafint OWNer mepioTpEPEToL GOUPOVO, LE TNV TN TNE X 6TOV AE0VA Z TOL GVOTNUATOG 0EOVMV
oV ydpov. To False pag deiyver 61 o1 dEovec eivon Global.
H yaw mepiotpépetor cOppova pe v tipn mg Yy otov X daéova, evd 1o True pog Aéet ot £xovpe
Local npocavatohoud a&ovov.

14.H 6éon mov Ba £xel To MOUSE Katd To TPEEYLO TOV oy vidlov Ba gival 6To KEVTPO TOL Tapafvpov.

15.Av evepyomomBel 1 KotdoToon otV omoin dexOUAcTE £(G000 OO TO MANKTPOAOYO TO TANKTpO R,
oo av maticovpe to R, 1d1€ TO OWnNer, dniadn to Empty0l Ba mepiotpagpei otovg d&oves o
6¢on 0,0,0.

ii.  Python script yua Tqv kivijon tov Hook *°!

import bge

def main(): !
1.

cont = bge.logic.getCurrentController() 2
hook_Mesh = cont.owner 3
keyboard = bge.logic.keyboard 4

movSpeed = 0.1 >

if bge.logic.KX_INPUT_ACTIVE == keyboard.events[bge.events. DOWNARROWKEYT: ®
hook_Mesh.applyMovement((0, 0, -movSpeed), False)

if bge.logic.KX_INPUT_ACTIVE == keyboard.events[bge.events. UPARROWKEY]:
hook_Mesh.applyMovement((0, 0, movSpeed), False)

if bge.logic.KX_INPUT_ACTIVE == keyboard.events[bge.events. LEFTARROWKEY]:
hook Mesh.applyMovement((-movSpeed, 0, 0), False)

if bge.logic.KX_INPUT_ACTIVE == keyboard.events[bge.events. RIGHTARROWKEY]:
hook_Mesh.applyMovement((movSpeed, 0, 0), False)

if bge.logic. KX_INPUT_ACTIVE == keyboard.events[bge.events. AKEY]:
hook_Mesh.applyMovement((0, movSpeed, 0), False)

if bge.logic. KX_INPUT_ACTIVE == keyboard.events[bge.events.ZKEYT]:
hook _Mesh.applyMovement((0, -movSpeed, 0), False)

main()
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. Xpnoipomolodue pia main() yio va ypdyoope to script

I'evikn Aettovpyia 1 omoia maipvel Tov controller tng Python tov cuvdéel pe to ouykekpipévo script
g Python kot to amotéhespa to amodnkevel oty petafinti cont

To avtikeipevo 6mov Oa epappootei oto script sivar to hook_mesh
Xpnomn tov TAnKTporoyiov cov Sensor
Aivovpe tiun og pia petapintn v movSpeed, v omoia Bo. ypNGILOTOGOVUE GOV ToYHTNTO

Av gvepyonombei £16060G 0d T0 TANKTPOAGYIO pE To TAKTpo down arrow, dniadn av mtotndei to
GULYKEKPIUEVO TANKTPO, TOTE B epappootei kivnon oto hook_mesh ctov z d&ova 660 givon kot n
Tiun g movSpeed. To false Snidvel 6TL 0 TPOGAVOTOAGIOG TOV AVTIKEWEVOD YivETOL KABOAMKA Kot
o1 TOTKAL.

ZOUE®VO, LE TO TOPOTAV®, 1) TPAOTH EVTIOAN LG AEEL OTL e To dOWN arrow to ovtikeipevo o
petaxvnOel Tpog ta KaTw, 1 dHTEPT OTL LE TO UP Arrow to avtikeipevo Ba petakivnOei Tpog ta mivo,
ue 7o left arrow mpog ta aprotepd, e to right arrow mpog ta. 616, pe 10 A TPOg 10, HEGH Kot UE T0 Z
Pog Ta €.
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